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Legal Disclaimer
This document and the information contained herein (collectively, the "Information") is provided to you (both the individual receiving
this document and any legal entity on behalf of which such individual is acting) ("You" and "Your") by AT&T, on behalf of itself and its
affiliates ("AT&T") for informational purposes only. AT&T is providing the Information to You because AT&T believes the Information
may be useful to You. The Information is provided to You solely on the basis that You will be responsible for making Your own
assessments of the Information and are advised to verify all representations, statements and information before using or relying upon
any of the Information. Although AT&T has exercised reasonable care in providing the Information to You, AT&T does not warrant the
accuracy of the Information and is not responsible for any damages arising from Your use of or reliance upon the Information. You
further understand and agree that AT&T in no way represents, and You in no way rely on a belief, that AT&T is providing the Information
in accordance with any standard or service (routine, customary or otherwise) related to the consulting, services, hardware or software
industries.

AT&T DOES NOT WARRANT THAT THE INFORMATION IS ERROR-FREE. AT&T IS PROVIDING THE INFORMATION TO YOU
"AS IS" AND "WITH ALL FAULTS." AT&T DOES NOT WARRANT, BY VIRTUE OF THIS DOCUMENT, OR BY ANY COURSE OF
PERFORMANCE, COURSE OF DEALING, USAGE OF TRADE OR ANY COLLATERAL DOCUMENT HEREUNDER OR
OTHERWISE, AND HEREBY EXPRESSLY DISCLAIMS, ANY REPRESENTATION OR WARRANTY OF ANY KIND WITH
RESPECT TO THE INFORMATION, INCLUDING, WITHOUT LIMITATION, ANY REPRESENTATION OR WARRANTY OF
DESIGN, PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, OR ANY
REPRESENTATION OR WARRANTY THAT THE INFORMATION IS APPLICABLE TO OR INTEROPERABLE WITH ANY SYSTEM,
DATA, HARDWARE OR SOFTWARE OF ANY KIND. AT&T DISCLAIMS AND IN NO EVENT SHALL BE LIABLE FOR ANY LOSSES
OR DAMAGES OF ANY KIND, WHETHER DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, PUNITIVE, SPECIAL OR
EXEMPLARY, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF GOODWILL, COVER, TORTIOUS CONDUCT OR OTHER
PECUNIARY LOSS, ARISING OUT OF OR IN ANY WAY RELATED TO THE PROVISION, NON-PROVISION, USE OR NON-USE
OF THE INFORMATION, EVEN IF AT&T HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSSES OR DAMAGES.
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1. Introduction
The Video Optimizer User Guide describes in detail the methods for collecting an application
trace with Video Optimizer. This guide describes how to open a trace and it includes a
reference section with the tabs, menus, options, charts, graphs, and statistics. This guide is
intended for app developers who are interested in testing the performance of their apps.

2. Overview
Video Optimizer is a diagnostic tool for analyzing mobile web application performance. Video
Optimizer automatically profiles your application and provides recommendations that let you
optimize performance, make battery usage more efficient, and reduce network impact.
The traces that Video Optimizer runs against your application are benchmarked against
recommended best practices. Video Optimizer looks at how your application (and your server)
is handling caching, and how you are managing the network connections for your application.
By optimizing against these best practices, your application will run faster, use the network
less (saving valuable battery life for your users), and improve the experience of customers
using your application.

2.1. Installation Requirements
To install Video Optimizer 4.6, be sure that your computer has at least 4GB of RAM.
Please use the hyperlinks below to get installation requirements and instructions for
specific operating systems -

•
•
•

Windows
Mac
Linux

2.1.1. Windows
• Java – Java 8 or above
• Wireshark
Wireshark is required for maintaining cross-platform compatibility of traces.
You can download it from https://www.wireshark.org/
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•

Choose Install Npcap

•
•

Choose Install Npcap in WinPcap API-compatible Mode
Wireshark normally installs in Program Files. If user chooses to
install in a different location:
o Add Wireshark to the System environmental variables path.
o Or configure in Video Optimizer Preferences.
See section 5.1.2

• VLC Media Player –
Video Optimizer uses VLC media player to play most types of videos
(namely mp4/SD|HD and mov/low-res videos). You need to have VLC
installed on your computer (you can download it from
https://www.videolan.org/vlc/). Version 3.x.x or higher is required.
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• FFmpeg & FFProbe Setup –
FFmpeg, and FFprobe are used by Video Optimizer in a few different
ways, including Video Analysis. You can download it from
https://ffmpeg.org/. FFmpeg normally installs in Program Files.
If user chooses to install in a different location:
•
•

Add FFmpeg bin folder to the System environmental variables
path.
Or configure in Video Optimizer Preferences. See section 5.1.2

Additional dependencies must be met to collect network or traffic data from
Android devices.

2.1.2. Mac OS
• Java – Java 8 or above
• Xcode –
•
•

Make sure you have the most current version
In a terminal, run xcode-select --install

• Homebrew – install Xcode before installing Homebrew.
•

Visit https://brew.sh to install

• FFmpeg – In the terminal, install with the command –
•
•

‘brew install ffmpeg’
It will also install ffprobe.

PATH - Mac OS uses Z shell and as such you want to configure your path
variables in .zprofile. See example.
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Note – For instructions on how to create a bash profile on Mac follow the
instructions specified at the link https://www.insightsjava.com/2022/01/how-to-create-bash-profile-onmac.html

2.1.2.1. Intel (Macs 2019 and before)
• Wireshark

Install the Intel version of Wireshark into /Applications.
• VLC Media Player
Video Optimizer uses VLC media player to play most types of videos
(namely mp4/SD|HD and mov/low-res videos). You need to have VLC
installed on your computer (you can download it from
https://www.videolan.org/vlc/). Version 3.x.x or higher is required.

Install the macOS version.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

2.1.2.2. Apple silicon
• Wireshark

Install the appropriate version (depending on which architecture of
Java you have installed) If you are using Intel builds of Java, you must install the macOS
Intel 64-bit version.
If you are using Arm 64-bit version of Java, then you must install
the macOS Arm 64-bit version.
• VLC Media Player

Install the appropriate version (depending on which architecture of
Java you have installed) If you are using Intel builds of Java, you must install the macOS
version.
If you are using Arm 64-bit version of Java, then you must install
the macOS (Apple silicon) version.
Additional dependencies must be met to collect network or traffic data from
Android, or iOS devices.
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2.1.3. Linux
• Java – Java 8 or above
• Wireshark
In terminal, use the following commands one by one sudo add-apt-repository ppa:wireshark-dev/stable
sudo apt update
sudo apt upgrade -y
sudo apt install wireshark
sudo apt install tshark
• VLC Media Player
It needs to be installed using ‘sudo apt-get install vlc’. If VLC is
installed in a different way, Video Optimizer will not recognize it.
• FFmpeg
FFmpeg is available in the default repositories. Open Terminal and
run the following command to install it.
o sudo apt-get install ffmpeg
Additional dependencies must be met to collect network or traffic data from
Android devices.

Note – Video Optimizer installer will alert you of the missing dependencies during the
install process.

3. Video Optimizer to Collect Data
Video Optimizer captures the data traffic of mobile devices. As data streams across the
network during a given period, Video Optimizer captures each TCP packet and matches the
packet information with recorded video of what the user is seeing on the device. Video
Optimizer also looks at other parameters from the mobile device such as signal strength,
network type, CPU & GPS usage, etc.
You can use Video Optimizer to test the following:
•
•

iPhone or iPad running iOS 14 or newer is supported.
Android devices (and emulators) versions 6.0 and up.
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Note: The original Android Collector works on Android versions 2.3.7 - 5.1 but requires
root access. See APPENDIX II for more information about how to use the legacy Rooted
Data Collector API.
Pcap Packet traces: Pcap packet trace files contain basic (network only) data that can be
captured using several different tools. Once captured, pcap files can be opened directly in
the Video Optimizer. Pcapng and pcap formats are supported.
Automated Collection using Video Optimizer SDK. To facilitate the integration of Video
Optimizer with developer tools, automated testing environments and Enterprise build
environments, we’ve exposed APIs for collecting and analyzing traces.

3.1. Prerequisites
This section describes the prerequisites for collecting a Video Optimizer trace on iOS
and Android devices.

3.1.1. iOS Prerequisites
Collecting a Video Optimizer trace on an iOS device requires the following:
Mac computer running OSX 10.8 or higher, with the following:
1. Administrator rights
2. Ability to use SUDO password from Terminal
3. Apple's XCode
Note - Xcode must stay up to date with the highest iOS version of the
devices that will be used to collect traces.
Required for maintaining cross-platform compatibility of traces.
4. For Apple silicon (M1/M2) machines, please ensure kernel
extensions are authorized using instructions from one of the
links below –
Kernel extensions in macOS - Apple Support
How to Enable and Activate Kernel Extensions on Apple Silicon
Macs (makeuseof.com)
5. Homebrew
Recommended to simplify the install of the following software packages
used by Video Optimizer.
Note – On Apple silicon, brew will install software at /opt/homebrew/bin

6. MacFuse
Required for retrieving HD video from iOS device
7. Libimobiledevice and ifuse for macOS
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Required for obtaining HD iOS traces. Note - With Apple silicon(M1/M2)
Macs, the default path has changed.
There are differences in the installation approach for Intel and Apple
silicon (M1/M2) architecture machines. Please find a script below that will
help you with the installation.
https://raw.githubusercontent.com/attdevsupport/VideoOptimzer/master/vo_
dependency_installer.sh

3.1.2. Android Prerequisites
To collect a Video Optimizer trace on an Android device, you must have the
following:
1. PC, Mac or Linux computer along with Android SDK installed (for ADB
control of device).
2. Android device running 6.0 or higher.
3. Android SDK (Level 23 or above)
Install SDK Platform Tools for using Video Optimizer.
Windows path
Add the locations of these components to your windows path:
•
•
•

Start Button>Computer>System Properties>Advanced
system settings>Environment Variables
Scroll down System variables to “Path” and select Edit
Add the paths to adb.exe, ffmpeg.exe, ffprobe.exe,
wireshark.exe to the end of the existing Path.

4. ADB path set in Preferences dialog.

3.2. Collecting a Video Optimizer Trace
Collecting a trace works similarly for all devices. Simply connect the device to your
computer and open the Video Optimizer application.
Step 1. Select Start Collector from the Data Collector menu.
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Step 2. Select a Device in the Start Collector dialog. Video Optimizer will discover all
iOS and Android devices connected to the computer. Figure above shows that
two devices are connected: an iOS device and an Android device, with State,
OS, API, Model, Device Name is detected.
Step 3. Select the Collector Type. The recommended setting is VPN, especially for an
Android device that does not have root access. Other collector types are
available for Android devices that are rooted.
Step 4. Optional: Select an Attenuate option. This lets you reduce the throughput of
the network connection, allowing tests on networks with lower bandwidth
profiles (for more information, see the Network Attenuation section). In the
Figure above Attenuation is not selected, so it is not being used.
Step 5. Optional: Secure collection is available on Android versions 6.0 – 13. Select
Yes for Secure if you want Video Optimizer to decrypt HTTPS traffic – providing
you with a more thorough analysis of the traffic transmitted during your test.
You will be prompted to install a certificate if this is your first time using secure
collection. On subsequent tests, you do not need to install the certificate.
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Step 6. Select a Record Video option. Depending on your device, there will be two or
more options available for recording the screen while you are collecting Video
Optimizer data.
o Low Res:1-2 frames per second. Advantage: Smaller video size
o HD: 8 MBPS, 1920x1080.
Note: This will generate very large video files. Generally, you should only
use this format for short traces. If HD video record fails, it may indicate that
there were not enough system resources, so try with SD or Low-res
settings.
o SD:SD video 3MBPS, 960x540 video – for a smaller size (but lower
quality) video.
Step 7. Click on the arrow button to add further trace collection details –
o
o
o
o
o

Description – add a description of the trace activities
Target App – the app that is being tested
App Producer – the details about the app producer
Trace Type – ex: video streaming, live video, downloading, browsing,
etc
App Selector – helps select the app that you want to target the
collection from.

Note: additional trace details can also be added at the end of the trace, or
after opening a trace for analysis.
Step 8. Type a trace name in the “Please enter trace folder name” box. This is where
all the trace files will be stored. Spaces and special characters are not allowed
and if you pick an existing name you will be asked if you want to overwrite the
previous trace.
Step 9. Click Start to begin collection on your device after you have selected the
appropriate parameters or click Cancel to prevent a trace from being run.
Step 10. iOS Only: Video Optimizer will prompt you to enter the OS password, this is
required to start the traffic capture utility.

If you get any unexpected error messages when starting an iOS trace, it is
likely that one of your dependencies is not installed correctly. Please
download the following script and run it to correct your dependencies –
https://raw.githubusercontent.com/attdevsupport/VideoOptimzer/master/vo_
dependency_installer.sh

Step 11. Android Only: First time when vpn collector is installed on the device,
following pop up is displayed to the user to grant permissions. Choosing “Yes” will
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grant the permissions automatically. Clicking on “No” will display all the permissions
on the device and user must manually allow all the permissions.

Step12. Android Only: When collecting a trace from an Android device, you may see
a security popup message about exposing sensitive info during casting/recording. This
is just a reminder that any sensitive information revealed during the trace will be
included in the recording. Your trace recording will only be stored on your computer
and will not be sent or stored anywhere else. You will need to click Start now in order
to proceed with gathering a trace.

3.2.1. Collecting a HD Trace: iOS Specifics (iOS 12 and above only)
iOS 12 added the functionality to be able to record the device screen. We now
have a companion app, capable of pulling the recorded video off the device as
long as the user requests it. The following section details some additional steps
that must be done to collect a HD video on an iOS device.
•

Enabling an iOS Device for Development
If you haven’t enabled Developer settings on your iOS device, this
section details how to do that. This needs to be done only once.
1. Connect the iOS device to the Mac computer.
2. Open XCode and from the Window menu >select devices and
simulators.
3. Select the connected device from the list of devices in the left nav.
4. Click Use for Development.
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5. Click Cancel when you see a prompt to join the “Apple developer
program and login with a paid developer account.” (You do not need
a paid account to continue.)
Note: Always start XCode before you start Video Optimizer so that
you can see that the device is detected and ready to use.
6. When the device is enabled for development, you will see a
“Developer” option on the Settings menu of the device.
•

Collect iOS HD Video
1. Attach the iOS device, that you want to collect from, to the Mac.
2. Launch Analyzer>Data Collector>Start Collector
3. Choose HD>Enter trace name>click start
4. On the Analyzer validate for the instructions pop-up message for user
to start screen recording

5. Continue to test the application for HD on the iPhone.
6. Click stop on live screen capture or on the Analyzer>Data
collector>stop collector.
7. Stop Screen recorder on the device

8. Trace summary is displayed. Enter the optional metadata information.
9. Click open.
10. Validate that the video played in the video viewer is played in HD.

3.2.2. Collecting a Secure Trace (Android steps, up to Android 13)
The Video Optimizer android collector can do an MITM based capture of secure
traffic. This requires a user certificate installed on the phone on which the trace
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is being captured. Following are the steps to be followed to capture a secure
trace.
Step 1. Install a certificate (required on first test)—if you have selected a secure
trace and have opted to install a certificate. Choose the VPN and apps
(not Wi-Fi) option for Certificate name on your device and select OK.

Step 2. Select OK to allow the VPN connection to start on the device—when the
trace is started, Video Optimizer installs a collection app on the device.
The app establishes a VPN connection and requests permission to allow
the connection.
Note: The VPN connection is a connection to nowhere. It originates and
terminates on the device. All packets flow through the network normally.
•

Secure collection: certificate install instructions for Android
Starting with Android 11, user must install the certificate manually on
the device by following the instructions given in the pop-up below and
follow the screenshots:
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Note - For Samsung devices, the user is prompted to save the
vocert.pem file in the Downloads folder. Once the file is saved, navigate
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to Settings->Biometrics and security->Other security settings->Install
from device storage->CA certificate->Install anyway->Download>vocert.pem. The user is then displayed a message that the CA
certificate is installed.
After following the above steps click ok on the Analyzer information
pop-up window and the following screens will appear on Analyzer and
then on device.
On Analyzer: First Time collection

On Device:
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3.2.3. Collecting an Attenuated Trace
Video Optimizer can attenuate a trace collection, restricting the upload/download
speed of traffic flowing through the VPN/MITM.
•

Android Attenuation
When you collect a trace, you can add a network throughput cap for
uplink or downlink, set in KBPS. This will limit all data traffic on the
phone to a maximum data throughput. This is a useful way to test your
mobile application in a network constrained environment; perhaps at a
busy sporting event, or in a country that does not yet have a LTE
network.
When you are collecting a trace, the default attenuation setting is
“None,” meaning that no attenuation is performed by default.

3.2.3..1.

Static Attenuation
Step 1. Select Slider from the attenuate options.

Step 2. Select Downlink to lower the throughput of the
packets being downloaded from the server or
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select Uplink to lower the throughput of the device
uploading files to the server.
Step 3. Set the speed to 4G, 3G or 2G on the slider. A
value between 3G and 2G will allow tests on “slow
3G.” Video Optimizer sets the attenuation value
that you selected as the maximum throughput
available for the entire test. Note: If you set a
maximum throughput value that is higher than the
actual speed of your network, you will not see an
improvement. Video Optimizer attenuation will
only SLOW the network throughput – it cannot
enhance the speed of your network. If your phone
is on a slow network, and attenuation is set to 4G,
it will still be a slow connection.

3.2.3..2.

Dynamic Attenuation
The Attenuate feature in Video Optimizer is a useful way to
test how apps and video behave in a constrained
environment. But when you are testing mobile video, it is
also interesting to consider how changes in network
throughput affect a stream that is in progress.
When network changes occur while a video is playing, the
player may change the bitrate of the video to ensure that the
video buffer remains full – because when the buffer is dry,
the video will stall. It may request multiple versions of the
same segment – yet only play the highest quality segment
received. Understanding how your video stream behaves in
changing network environments is the best way to
understand and prevent stalls from occurring.
The dynamic profile option allows you to change the network
speeds while the trace is running. Now you can test your
app or video in changing network conditions (that you can
control and re-use systematically and in a repeatable
manner). Video Optimizer Library folder->Default_Profile
file has been updated with an additional Packet Latency
parameter (in milliseconds) in the end of each line for
Dynamic Attenuation which is accounted in VO while taking
a collection.
Step 1. Select Profile from the attenuate options.
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Step 2. To modify the default profile, you can create your
own script file—just modify the default_profile.txt
document in a text editor and save with a new
name.
Step 3. The format of the text file is comma delimited, with
4 entries per line: time in seconds, downlink in
KBPS, uplink in KBPS & Latency. 102400 KBPS
indicates “no throttle” in that time frame.
Step 4. For example, in the figure below, the first 20
seconds of the trace, throttling begins at 6144 kbps
downlink, 1024 kbps for uplink and 0 ms for latency.
After that, next 20 seconds, throttling adjusts to
5120kbps for downlink, 1024 for uplink, and 50 ms
for latency.

•

iOS Attenuation
Starting with Catalina and above, user must use a LAN or an iOS device
for setting up the hotspot connection.
Note: Previous mac OSs allowed any source of hotspot connection.
Following are the steps to setup the environment on MAC.
Step 1. Choose Apple menu > System Preference, then click
Network.
Step 2. Select Ethernet (wired) or the USB tethering for network
connection.
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Step 3. Turn the Mac Hotspot on.
Step 4. Choose Apple menu > System preferences, then click Sharing
, open Sharing preferences if it isn’t already open.
Step 5. Select the internet Sharing checkbox.
Step 6. Click the “Share your connection from” pop-up, then choose
the Internet connection you want to share.
Step 7. Select the type to share your internet connection in the “To
computers using” list.

Step 8. Select Wi-Fi.
Step 9. If your Internet connection and your local network use Wi-Fi,
sharing your internet connection disrupts the network.
Step 10. Observe on the Mac, the internet sharing icon is seen in the
Menu bar.
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Following are the steps to setup the environment on wi-fi on iOS
device:
Step 1. Go to settings>Wi-Fi. Turn on Wi-Fi and Airplane mode.
Step 2. For wi-fi: select the Mac computer shared hot spot from the
listed networks, then enter the password, if required.
Step 3. Adjust the settings for a Wi-Fi network: Select the more Info
button next to a network. Set up a HTTP proxy.
Step 4. Set Proxy: Enter the IP address of the Mac computer
Hotspot and port number is “8080”
Step 5. Depending on the device make sure the wi-fi and air-plane
mode are enabled and displayed.

3.2.4. iOS Secure Collector
Introduction:
Video Optimizer iOS collector can be used as a man-in-the-middle HTTPS
proxy, enabling you to view the communication between web browser and SSL
web server.
Video Optimizer does this by becoming a man-in-the-middle. Instead of your
browser seeing the server’s certificate, Video Optimizer generates a certificate
for the server and signs it with its own root certificate (the Video Optimizer CA
Certificate). Video Optimizer receives the server’s certificate, while your
browser receives Video Optimizer’s certificate. Therefore, you will see a
security warning, indicating that the root authority is not trusted. If you add the
Video Optimizer CA Certificate to your trusted certificates you will no longer see
any warnings – see below for how to do this.
Video Optimizer still communicates via SSL to the web server. The
communication is SSL (encrypted) from web browser to Video Optimizer and
SSL (encrypted) from Video Optimizer to the web server.
Connection Set-up for Secure Trace:
Pre-Requisite- MITM Proxy setup
→Navigate to Menu>Start collector to launch the start collector window.
→On the start collector window Secure(yes) should display MITM status with
Internet Sharing Status, Server address IP and server port and then enter a
valid trace name and then click start. Refer to the screenshot below.
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→Navigate to Safari and type in IP address 192.168.2.1:9091 to install the SSL
certificate on the phone.

→Navigate to settings>general>Profiles and Device Management to verify that
Video Optimizer is present in the configuration profile and click on it to see that
the certificate is verified.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

→ If you are on iOS 10.3 or higher, open the Settings>General > About >
Certificate Trust Settings, and find the Video Optimizer Proxy certificate, switch
it “ON” to enable full trust for it.

→Open Safari or Google to validate the certificate.
→On Safari following screenshots display the method to validate secured

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

→On Google click on the lock symbol to validate that the connection is secure.
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3.3. Testing your Application
Now that the Video Optimizer is running on your mobile device, you can run tests on
your mobile application or website.
When testing your application, use your app like a typical user. Test logging in, or other
common use cases. Follow general test cases that you may run on each build to ensure
that the application functions properly.
Note: All the data transmitted during your test is being recorded, and the screen may
also be recorded if you have chosen to record video. Please only use test data while
using the Video Optimizer, or your private credentials will become available to anyone
who has access to the trace.

3.4. Ending the Trace
When you have completed the Video Optimizer recording, use the following steps to
stop the trace, confirm that the trace files have been pulled to your computer, and begin
your Video Optimizer analysis.
Step 1. Stop the trace in one of the following ways.
a. If you are collecting video: Click the stop button on the video viewer (as
shown in Figure).

b. If you elected to not collect video: Stop the trace using the Stop Collector
option on the Data Collector menu (as shown in Figure).
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Step 2. When the trace collection is stopped, the files will be pulled across to your
computer. The trace will be saved by default in the VideoOptimizerAndroid /
VideoOptimizeriOS trace folder depending on the device used.

Step 3. Once the files have been pulled across (this may take a while if you recorded
HD or SD video due to the large file size), the Confirm window is displayed
(Figure). The fields under the Additional notes section are editable and you can
enter further details about the trace. You can use the Notes section to add
details about the trace being collected. Next, you can open the trace in the Video
Optimizer analyzer or click “OK” to continue without opening the trace.

Step 4. The trace folder contains a file called environment_details.json which records
the environment when the trace was taken. This file is created when the trace
is launched. It displays the following details –
•

Trace path – location where the trace is saved
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•
•
•

•

•
•
•
•
•

Date & Time - Date and Time information with local time zone of the
trace
VO version – Video Optimizer version
Collector details –
o VPN version
o Xcode version
▪ dumpcap version
▪ libimobiledevice version
Platform
o Mac
o Windows
o Linux
OS version
Java version
voTimeZoneID – computer’s timezone ID
voTimestamp – computer’s UTC date
Device the trace was collected ono OS version
o Platform
o Rooted
o Timing offset
o deviceTimeZoneID - TimeZone of the device
o deviceTimestamp - Date/Time of the device
o timeDiff
o localIpAddressList - includes both the IPV4 and IPV6
addresses from the networkInterfaceList plus the VPN
collector. (Populated on Android only)
o networkInterfaceList – includes the Network IPs for the
connected device. (Populated on Android only)
o voIpAddressList - includes the IPV4 and IPV6 addresses for
the computer running Video Optimizer at the time of
collecting a trace.
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4. Analyzing a Trace
Video Optimizer will perform an analysis of your network trace, including the radio resource
and energy usage of the applications run during the trace. Video Optimizer works from
application traces gathered through its Data Collector to do the analysis.
Video Optimizer provides the following:
•
•
•

Visibility into radio resource and energy utilization.
Benchmarking of resource efficiencies.
Automatic diagnosis of application inefficiencies.

4.1. Opening a Trace
When you open a trace in Video Optimizer, the data is evaluated against a set of
recommended best practices. Video Optimizer looks at how your application (and your
server) is handling caching, how you are managing the network connections for your
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application, how your app is using HTML, whether your app is treating data securely,
and how it is handling video streaming. Use the following options to open a trace file.
a.
Select Open Trace from the File menu to display the Open dialog box.

Select a trace folder and click Open. The trace files are loaded, and Video
Optimizer begins analyzing the data.
Note: The time required for Video Optimizer to complete the analysis depends
on the size of the trace. As soon as the analysis is complete, all the content tabs
in the Video Optimizer are updated with the analysis results.
Video Optimizer can recognize a folder which has one packet trace (.cap or
.pcap file) and one video file (.mp4 or .mov) and convert it to a Video Optimizer
trace folder. For example, if a pcap file was captured on an Android device using
the PCAPdroid app and a mov/mp4 file was created during this capture using
Screen Recording, and these files were placed in a folder, Video Optimizer
would be able to open this folder as a trace folder and perform video analysis
for this capture. Similarly, it would also work with pcapng files captured if using
the Wireshark app and a mov/mp4 file present in a folder.
Additionally, a folder with just a packet trace and no video in it can also be
converted into a trace folder in the same manner.
b.

Select “Open Trace with Time Range…” from the File menu.
A partial section of a trace can be opened and analyzed, excluding data before
a start point and eliminating data after an end point. This can be helpful if there
is unwanted data in an otherwise good trace. For example, if a speed test was
run at the beginning of a trace, but you don’t want the speed test data included
in your app analysis.
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The dialog displays
•

Frames from user’s device video (video.mp4 or video.mov).

•

Time Range
o

o

Start Analysis:
▪

Slider - user can slide it or select it, then use left or
right arrow keys for fine control.

▪

Text field - user can enter a value directly, image
gets updated after leaving the text field

End Analysis:
▪

Slider - user can slide it or select it, then use left or
right arrow keys for fine control.

▪

Text field - user can enter a value directly, image
gets updated after leaving the text field

•

Configuration Name - Text field where the user can enter a name for the
time range. Naming is optional if user just wants to click on the Analyze
button to analyze the trace for the specified trace range.

•

Auto Launch -

•

o

Default – time range that is used to automatically launch the
trace.

o

Manual – time range the user must manually select to
launch the trace with the specified time range.

A button bar at bottom of dialog
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o

o
o

o

Save
▪

if no configuration name is specified, a popup
message - "Invalid: cannot be saved without a
name" is displayed to the user

▪

saves any changes

Save & Analyze - Saves then continues with opening trace
with selected time range
Analyze - Analyzes trace with the displayed time range,
does not require a name, since it will not save a new
configuration or any changes if editing.
Cancel - does not save changes or does not open a trace.

User will be able to scan/play through the video to set start and end time-range.
If the start time is beyond the end time, the user is displayed an error message

Opening a trace with Open Trace with Time Range... that does not contain a
video.mov or video.mp4 will result in an Error Dialog displaying "Exception in
TimeRangeDialog: No Device Video file".

If time-range(s) already exist they will be listed in the Time Range Chooser
dialog.
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Time Range can be added, edited, selected, or deleted. An entry, “FULL”, is
created at the top of the list as a Default and will display the complete trace
range, after user creates the first configuration. When setting a different entry
to be Default, any entry that was Default earlier will become Manual. At any
time, there can only be one entry marked as Default. If the Auto Launch option
for a time range is selected as Default, it will be marked with an asterisk to
denote the default time range. Any time range that is Default will be the range
used to open the trace in the future. Selecting a time range and clicking on the
Launch button opens a part of a trace specified by a time range. Progress dialog
will display a second line, detailing the time range being used while opening a
trace.

Note: If a trace has a Default entry and the user wants to bring up the chooser,
they need to use the menu, File->Open Trace with Time Range.
For traces that have time range set, and none of the time ranges are marked as
Default, the File->Open Trace, and the File->Open Recent menu options
display the following dialog to let the user know that this trace has time ranges
detected

and displays the chooser dialog to let the user choose the time range to launch.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

A new label "Time Range:" is displayed in the Best Practices/Results tab
summary section which lists the time range used for the trace that was opened.
When time ranges are created, they are saved in a json file called timerange.json in the trace folder. It will contain one or more time ranges. It will list
the details of the time range saved such as the Title, the time range type –
Default or Manual, the Start Time, End Time, and the Range.

If a time range is marked as default, Open Trace or Open Recent will open the
trace with the specified time range automatically or by default. If none of the
time ranges are marked as default, the time range chooser dialog is displayed
so that the user can select which time range to open the trace with.
By deleting all entries or time ranges, the entire json file will be deleted.
c.

Select “Open Pcap File…” from the File menu (instead of Open Trace) to open
pcap/pcapng trace files. These files allow you to view statistical and analytical
data for the trace based on the packet information in the file, but you will not be
able to view any video information in the Viewer and you will not see any
information for peripheral applications (i.e. GPS or Bluetooth). Note: If the trace
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is too big to load due to the current memory setting then Video Optimizer will
quit and restart and present a dialog with options for the user.
Video Optimizer needs to create several folders while performing analysis.
When using the “Open Pcap file…” feature to analyze a standalone pcap or
pcapng file, which may not be in a Video Optimizer Trace folder, a dialog will be
displayed with options of performing the analysis in either a temporary or a
permanent folder. The new folder’s name will be the name of pcap/pcapng file
without the extension. The new folder will be created at the same path of the
pcap/pcang file. The temporary folder will be deleted immediately after the
analysis. Tools->Edit Metadata option will be disabled, and the user will not be
able to save any metadata or any notes in the Trace Notes section. If the user
attempts to double click the notes area, it will display “Sorry, You cannot edit or
save notes on filename.cap, try reopening the PCAP and approve conversion.”
If permanent folder analysis is selected, the original pcap/pcapng file is moved
to the newly created folder. The user is able to save metadata and trace notes
when the permanent folder option is selected.

“Open Pcap File…” function remembers the location of the last PCAP file
opened. For any exports or images to be saved for the currently opened pcap
file, the location displayed in the Save window is the same location where the
opened pcap file resides.
d.

Open Recent: User has the option to open the recent 15 traces/files from
Analyzer which allows user to find the last few traces/files. File->Open Recent
menu displays the recently opened pcap, and pcapng files as well. If the user
had decided to create a folder when opening a pcap file, the Open Recent menu
will list the folder name in the menu. If a folder wasn't created, the menu will list
the pcap file including its extension to differentiate files from folders.
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Open Recent file: When user re-names any file which was opened and
displayed in the open recent file, the file name will be removed from list. The file
name will not appear in the open recent until the user re-loads the trace. Also,
user can re-name the trace with any special characters and load it in the
Analyzer. For error traces like, no activity in traffic file, or, there is no traffic file
in the trace, will not be shown in the open recent files. User can hover over the
open recent menu names and a tooltip will be displayed which will list the full
path for the trace/file.

4.2. Best Practices Results
Video Optimizer trace analysis starts at a high level, with the Best Practices Results,
and then it helps you to pinpoint the issue as much as is required to solve the problem.
The high-level views work well for executive readouts, while moderate digging might be
useful for a deeper dive, and for a deep technical understanding – you can dig even
deeper.
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The top of the Best Practices/Results tab tells you some basic information about the
trace such as the date, trace name, and information about the device that was used for
the test. The trace name is clickable and when clicked opens the trace folder. It also
displays the details of the trace collected as entered by the user. Double clicking on the
Trace Notes section is a shortcut into the Metadata editor section to be able to make
changes to the trace information and trace notes. The Summary section reveals a few
high-level statistics recorded in the trace. Right below this is the Tests Conducted
section, which contains a summary of the best practices so that you can quickly
determine which best practices failed. The below screenshot refers to a trace that is
uploaded in the analyzer.
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A ‘N/A’ icon is displayed to indicate that a Best Practice is not applicable when a trace
does not have relevant data available for analysis. Refer the image below -

Generally, the Tests Conducted section of the Best Practices tab is the best place to
start to improve your application.
Step 1. Click on the text for the Best Practices test to go to a larger summary. A green
checkmark means that the test was successful, and a red x means that the test
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failed. For example, here is a trace that failed the Duplicate Content best
practice.

Step 2. Review the About section to learn more about this best practice. Review the
Results section for details about how to fix the problem. This example has a
table listing files that were sent multiple times including the count of downloads
and the file name.
Step 3. Click one of the table entries for more information—every best practice table will
let you do this. In this example, you are taken to the full list of duplicate content
in the Overview tab, from which you may be able to determine the time ranges
or other details to figure out the issue.

Step 4. Select a row in the table and click View to view the contents of the file. This
helps when a file name is obscure, and you don’t really know what the file is or
the type of content. The Diagnostics tab is displayed, and you can see the
request/response for the file.

Step 5. Click Content View to see the headers. In Figure, the top table shows the IP
and domain (pbs.twimg.com) indicating a request from Twitter’s image servers.
The bottom table shows the request/response. In this example, the file is coming
from Twitter. Check the cache-control parameter in the DOWNLINK header to
see if the file has the correct cache headers. In Figure, cache-control shows a
max-age of 604800s—a cache timeframe of one week—so in this application,
the image cache may not be properly set to store files locally on the phone.
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4.3. Private Data Tracking
The Transmission of Private Data best practice test allows you to examine all the
decrypted and clear text data files for leakage of private data.
Step 1. Select Private Data Tracking from the Tools menu.

Step 2. In the Private Data Tracking dialog, complete the fields that apply to your trace.

Step 3. Click OK to analyze the trace for these values. A report will be provided for you
in the best practices tab. The Data Types and Data Values in Figure were found
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in the Video Optimizer trace because they were entered in the Private Data
Tracking dialog.

Step 4. Click one of the rows in the table to see the Diagnostics tab. The top table shows
the TCP stream and the bottom table shows the Request/Response View.

4.4. Video Analysis
Video Optimizer contains several functions to analyze the delivery of streaming video in
your mobile application. These specialized tools have some unique features that require
additional configuration.
When testing video, your trace should ideally be of a DRM free video, and the application
should allow screen recording. Video Optimizer can perform several analyses without
these two features, but the examples in this section are of a trace with a DRM free video,
and the recorded screen.

4.4.1. Video Analysis Setup
Begin by opening a trace with video content in it, but before beginning analysis,
there are a few manual steps required.
Step 1. Select File>Preferences>Video.
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Step 2. Enter the Targeted Startup Delay in seconds. This is the KPI (Key
Performance Indicator) requirement for how quickly a video should begin
playing. The default is set at 10 seconds. A video that takes longer to
begin playing than the value set for Startup Delay will fail the Video
Startup best practice.
Step 3. Enter the Stall trigger in seconds. The default value is 0.05s (50ms).
Stalls that are under the threshold value set for Stall trigger will not be
counted in the best practice. For example, the value in Figure means that
stalls under 0.05s will not be counted in the best practice.
Step 4. Enter the Preferred Maximum Buffer. Video Optimizer measures the
amount of video stored in the buffer. Here you can set the max buffer size
(in MB). For example, the value in Figure denotes a 100 MB video buffer.
Step 5. Stall Pause Point - if a segment is late to arrive, the currently playing
segment must pause before it finishes playing, a value greater than 0 is
suggested.
Step 6. Stall Recovery – estimated time it takes for a player to start or resume
playing once segments are arriving. A value greater than 0 is suggested.
Step 7. Click OK.

4.4.2. Configuration Required
From the best practices tab, user can set the start-up delay by clicking on the
icon of any of these three best practices - Video: Stalls, Start-up Delay, Buffer
Occupancy. Refer to the screenshot below –
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4.4.3. Analyzing a Video
Video Optimizer will extract streaming video from the trace, when successful, you
will see the video stream table as in step 1 below. However, sometimes there are
video requests, but no streams showing, in such a case, the user is displayed a
message that ‘Video segments could not be assigned to a Video Stream.’
Video Optimizer can handle Dash, HLS, MPEG, as well as Transport Stream. For
other video streaming you may need to use inferencing.

Step 1. Navigate to Video tab->Video Stream and choose a stream. You can
choose by using the checkbox or clicking the Set/Edit StartupDelay
button. The first stream is chosen by default.

Step 2. On selecting the stream, the Segment Throughput graph, the Segment
Progress graph, and the Segment Buffer graph are displayed.
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The Segment Throughput graph displays the throughput for the video and
audio segments in the case of demuxed video and for the segments in
the case of muxed video. Hovering over each of the points displays a
tooltip with the following information – Segment #, Track #, Download
Start Time, Download End Time, Duration, and the Throughput.

The Segment Progress graph displays the progress of the Video and
Audio segments. Hovering over each of the points displays the following
information - Segment #, Track #, Download Start Time, Download End
Time, Duration, and the Progress. The graph also displays the Video and
the Audio PlayTime. Hovering over each of the points displays a tooltip
with the following information – Segment #, Track #, Play Start Time, Play
End Time, Duration, Progress, and the Content (Video/Audio). The
Legend in the graph helps the user differentiate between the various
graphs. For a muxed video, there would be just two graphs – the
Download_Progress graph and the PlayTime_Progress graph. Graph
refreshes when each stream is selected.

The Segment Buffer graph displays information about the playback buffer.
Hovering over the points in the graph displays the following information –
Segment #, PlayBack Buffer in seconds, the TimeStamp, and the Plays at
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value. The graph refreshes when each selected stream has its startup
delay set.

Double clicking on the header of the Segment Throughput, Segment
Progress, and Segment Buffer graphs can expand/collapse the graph.
On hover over the headers, a tooltip is displayed to let the user know
about the same.

Step 3. Click on Set StartupDelay button in red which indicates that the startup
delay is not set or Edit Startup Delay in blue which indicates it was
previously set. If the video you tested was DRM free, the view will be of
the first frame in each chunk.
User input window is displayed

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

In the above image, user events and video start up time are displayed.
Selecting an event or segment will highlight the entire line and only one
event or segment can be selected at any time. If there are no user events
in the trace then the user event area will be collapsed. If there are no
segment thumbnails then the segment thumbnail area will collapse.
In the User Touch Event section, navigate through the touch events
viewing the simultaneously changing frame images on the right-hand side
of the dialog to choose the time stamp of the precise video playback
requested time. The time chosen should be before the Manifest Request
Time displayed at the top of the window and less than the time range
found in the first segment. Enabling the Settings->Developer Option>Show Taps option on an Android device helps with the identification of
the precise video playback requested time. Next, position the slider in the
Video Startup Time window to a point where the video startup time is
greater than the arrival time of the first segment. The arrival time is the
second number in the highlighted Time Range. In the example above its
498.931. Click Set.
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Initially video streams will have an estimated start time. These will show a
red StartupDelay button. You can set the actual startup delay by clicking
this button, the button will become green while using the dialog and
becomes blue once the set button has been clicked.

Step 4. Once the Startup Delay has been set for a stream/streams, the values for
the Play requested time and the startup time are saved in a file called
video_stream_startup.json which is saved in the trace folder. Subsequently when
the trace is opened at any time and the startup delay must be set, these previously
set values are displayed when the Startup Delay window opens for the stream. A
validationStartup field displays the following •

USER - User has set the startup delay

•

ESTIMATED - VO estimated the startup, user has not set startup delay
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If the default video analysis does not provide any results and a manifest
is available, then the CSI(Chunk Sequence Inferencer) feature can be
used for analysis. Adaptive Bitrate Streaming behavior and QoE
measurement and analysis is becoming challenging due to the increase
in usage of end to end encryption protocols like HTTPS and QUIC. CSI
helps here in inferring the ABR behavior based on packet size and timing
information that is available in the encrypted traffic. The CSI feature in
Video Optimizer is based off of research by Shichang Xu, Subhabrata
Sen, and Z. Morley Mao presented in the white paper “CSI: Inferring
Mobile ABR Video Adaptation Behavior under HTTPS and QUIC”, 2020.
https://doi.org/10.1145/3342195.3387558
To use the CSI feature, after loading a trace, navigate to Video tab>Video Stream, check the CSI checkbox and click on the Load button to
load the manifest.
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A video_stream_startup.json file, which records the play requested time,
and startup time set, is stored even for CSI analysis when the startup
delay for the stream has been set. For Subsequent analysis of the same
trace, when startup delay has to be set, it displays the stored values when
the startup delay dialog opens up.
When performing CSI analysis, if the manifest loaded is in a path different
from the trace folder, then a copy of the manifest file is stored within a
CSI subfolder for the trace folder. If the CSI manifest exists in the root
trace folder, then it is moved to the CSI subfolder. If the CSI subfolder
already has the manifest, then it is not copied again. If the CSI subfolder
already has an alternate manifest in it, the user is prompted and asked if
the existing files should be deleted. After the CSI analysis is completed,
the status of the CSI analysis along with the new path for the manifest is
stored inside of the CSI subfolder in a file named CSIState.json.
Subsequent analysis of the same trace will automatically lookup the
stored CSI status and auto-analyze CSI.
•

Viewing Buffer Details
The Diagnostics tab shows the Playback Buffer (the seconds of video
stored locally) and the Buffer Occupancy (the KB of video stored locally).
Examine the Video chunks line closely—in Figure there is a red line
starting at chunk 1 and ending when the chunk appears on the screen—
in this case, around 569s. This allows Video Optimizer to calculate if the
video buffer runs out of video time or KB. When this occurs, there is no
more video to play, and a stall occurs to the viewer. Video Optimizer will
use the startup occupancy found at the start to estimate when the video
will resume playing. Please note some processing now happens in the
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background for video stream analysis. As a result, you may notice the
image of a thumbnail updating over time.

•

Getting Video Information
1. Move the pointer over a video chunk to determine when the download
started, stopped, played on the screen, and the number of KB in the
chunk.

2. Point to the Play Back Buffer and Buffer Occupancy lines for more
information about how much playback is stored in the buffer and how
much is used. In the Image below for segment 6, at 32.930, the video
buffer has 4.16MB of data, which contains 59.590s of video playback
time. These steps will also allow Video Optimizer to calculate the data
presented in the Video Best Practices.

4.4.4. Video Best Practices
The following are examples of the best practices in Video Optimizer. These best
practices are still very experimental and are simply providing information. As
Video Optimizer matures, these will become fully fledged tests with pass and fail
criteria.
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Video Conditions
1)There is no video in the trace
o
o
o
o
o

[NA] across all VBP
Response: No streaming video data found.
no Stream
no segments
no urls
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2)Video not handled in the trace
o [Config_Required] across all VBP (no analysis)
o Response:Video Optimizer was unable to analyze video stream
file(s) Hint: look for ways to locate Stream/segment information
with the Video Parser Wizard. Click here to select Request URL
<a href="selectStream"><b> Stream</b></a> on the Video tab
o no Streams
o no segments
o urls exist
3)There is only one invalid Stream created.
o [Config_Required] across all VBP (no analysis)
o Response: Invalid Streams. Video Optimizer did not have enough
information for analyzing streaming video. Hint: look for ways to
locate segment information with the Video Parser Wizard. Click
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o
o
o

here to select Request URL <a href="selectStream"><b>
Stream</b></a> on the Video tab.
Stream - invalid
segments
urls exist

4)There is only one valid video Stream created
o apply tests to all VBP for selected Stream only
o Stream-Valid
o segments
o urls Exist
5)There is only one valid Stream but de-selected video Streams
o [Config_Required] across all VBP (no analysis)
o Response: No Stream is selected. Please select a <a
href="selectStream"><b> Stream</b></a> on the Video tab.
o Stream
o segments
o urls exist
6) There are Multiple valid Streams
One selected
o [Config_Required] across all VBP (no analysis)
o Response: Please select only one Stream on the Video
tab. Click here to select a <a href="selectStream"><b>
Stream</b></a> on the Video tab.
o none selected
o [Config_Required] across all VBP (no analysis)
o No Stream is selected. Please select a <a
href="selectStream"><b> Stream</b></a> on the Video tab.
7) There are Invalid with valid Stream
o one Selected Stream
o apply tests to all VBP for selected Stream only
o ignore invalid Streams
8)There are invalid with valid Stream
o none Selected Stream
o [Config_Required] across all VBP (no analysis)
o Response: No valid Stream has been selected. Please select a <a
href="selectStream"><b> Stream</b></a> on the Video tab. Note:
There are invalid Streams detected. Video Optimizer did not have
enough information for analyzing streaming video. Hint: look for
ways to locate segment information with the Video Parser Wizard.
Click here to select Request URL <a href="selectStream"><b>
Stream</b></a> on the Video tab.
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5. Video Optimizer Reference
The following sections are a complete reference of the Menus and Content Tabs that are
available in Video Optimizer.

5.1. Menu
Video Optimizer has the following menus.
Menu
Description
File

Contains options for opening trace, opening Trace with Time
Range, opening Pcap File, Open Recent, Preferences, Printing
results, and Exiting the application.
Contains options for loading and customizing device/trace
profiles.

Profile
Tools

Contains options for running a Pcap file analysis, running a
Time Range Analysis, Export Results->HTML, Json, Excel,
Export Session Data, Edit Metadata, Private Data Tracking,
Video Parser Wizard.
Contains options for displaying the video viewer, filtering the
set of data that appears in the analysis and diagnostics based
on application, IP address, and time range, and configuring
which data should appear in the Diagnostics Chart.

View

Data
Collector

Contains options for accessing the Video Optimizer Data
Collector.

Help

Contains options for displaying the Video Optimizer version,
the FAQ page, User Documentation,
Dependencies, Support, Downloads, and other Help
documentation.

5.1.1. File Menu
File menu contains the following selections.
Selection
Description
Open Trace

Opens a file for trace analysis. When this menu item is
selected, a dialog box is displayed that prompts you to
select the location of the trace folder containing the
trace files. You must select a trace file using this
command before you can view the trace analysis of
that file.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Selection

Video Optimizer User Guide

Description

Open Trace
with Time
Range

Opens a part of a trace, with a time range. When this
menu item is selected, a dialog box will open the
frames from the device video. User will be able to
scan/play through the video to set the start and end
time-range. If time-range(s) already exist they will be
listed in the chooser dialog. User can create, edit,
select, or delete time-ranges. The time-range will be
used to open the trace.

Open Pcap
File

Opens a Pcap/pcapng file for packet data analysis.
When this menu item is selected, a dialog box is
displayed that prompts you to select the location of the
Pcap/pcapng file. You must select a Pcap/pcapng file
using this command before you can view a packet
data analysis of that file.

Open Recent

User has the option to open the recent 15 traces/files
from Analyzer which allows user to find the last few
traces/files.

Preferences

Opens a Preferences dialog where you can choose
the Best Practices that you want to analyze and set a
path for the Android Debug Bridge (ADB), Max heap in
GB and Logging level. User can also set the
preferences using the Video tab.
Prints the results that are displayed when the Best
Practices or Statistics tab is selected. This menu
option is only enabled when the Best Practices or
Statistics tab is selected.
Exits the Video Optimizer application.

Print

Exit

5.1.2. Preferences
This feature opens a dialog with three tabs available, General, Best
Practices, and Video. Select Preferences from the File menu. Select
the General tab.
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• Enter the Max heap in GB. Here you can set the
maximum memory heap size for Video Optimizer (in GB).
For example, the value in Figure above denotes 12 GB as
the heap size. If the total system memory is 8GB or greater
then you can choose from 2 GB to within 4GB of Full
memory. If the total system memory is less than 8GB then
the memory allocation allowed is up to 85% of total
installed memory. Only one decimal point value is allowed
and no letters/special characters are allowed. An error
message is displayed if the value entered is invalid or out of
range.

•

Enter the Adb Path. This is the location of the Android
Debug Bridge (ADB) on your computer.
Note: When entering the ADB path in this dialog, you
must include the “adb.exe” at the end of the path.

•
•

Wireshark path: required.
iDeviceScreenshot Path: required on iOS for screen
capture.
ffmpeg path: required for video analysis
ffprobe path: required for video analysis
Logging Level: There are 5 types of levels that user can
choose – Trace, Debug, Info, Warn, and Error.
Select the Best Practices tab.

•
•
•
•
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•

Choose the best practices that you want to analyze
while opening the trace.

•

Select/Deselect All
User has the ability to select or de-select all the best practices
preferences.
• Select Video
• Here you can modify the parameters for pass/fail
criteria for some of the video best practices. In the
screenshot below, a startup delay over 8s is a warning.

•

The Save Only button only saves the current
preferences and doesn't reload the trace. It will not
affect the current state of analysis of an open trace,
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changes will only be seen after opening another trace
or using Save & Reload. The Save & Reload button
saves the changes in the Preferences dialog, a refresh
is done on the trace and the selected values are
persisted across Video Optimizer launches. This means
that only the selected best practices are run while
opening the trace. Also, we limit the video segments to
be displayed in the diagnostics and Video tabs when
any of the Video best practices or any of the Image best
practices such as Compression, Metadata or Format
are selected for analysis.

5.1.3. Profile Menu
The Profile menu contains the following selectionsNote: Profiles are intended for advanced users of Video Optimizer trace
analysis.

i.
ii.

Selection

Description

Load

Loads the selected Profile.

Customize

Displays the attribute values of the selected
Profile and allows you to edit them.

AT&T 3G Profile Network and Device Attributes
The following network attributes are defined for the AT&T 3G profile.

Network Attribute

Description

Carrier

The network carrier for the device.

DCH (Active)->FACH
(Standby) timer (sec)

The amount of time (in seconds) used
when the RRC state changes from
(direct channel) DCH to (forward access
channel) FACH.
FACH (Standby)->IDLE timer The amount of time (in seconds) used
(sec)
when the RRC state changes from
FACH (Forward access channel) to
IDLE.
Min IDLE->DCH (Active)
The minimum amount of time used (in
promotion delay (sec)
seconds) when the RRC state is
promoted from IDLE to DCH (Active).
Avg
IDLE->DCH
(Active) The average amount of time used (in
promotion delay (sec)
seconds) when the RRC state is
promoted from IDLE to DCH (Active).
Max IDLE->DCH (Active)
The maximum amount of time used (in
promotion delay (sec)
seconds) when the RRC state is
promoted from IDLE to DCH (Active).
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Description

Min FACH (Standby)->DCH
(Active) promotion delay (sec)

The minimum amount of time used (in
seconds) when the RRC state is
promoted from IDLE to DCH (Active)
and FACH (Forward access channel) to
DCH (Active).
Avg FACH (Standby)->DCH
The average amount of time used (in
(Active) promotion delay (sec) seconds) when the RRC state is
promoted from IDLE to DCH (Active)
and FACH (Forward access channel) to
DCH (Active).
Max FACH (Standby)->DCH
The maximum amount of time used (in
(Active) promotion delay (sec) seconds) when the RRC state is
promoted from IDLE to DCH (Active)
and FACH (Forward access channel) to
DCH (Active).
RLC threshold for uplink
The RLC threshold value (in bytes) for
(bytes)
uplink.
RLC threshold for downlink
The RLC threshold value (in bytes) for
(bytes)
downlink.
Threshold for resetting DCH The threshold for resetting the DCH
(Active) timer (bytes)
(Active) timer (in bytes).
Timing window for resetting
The timing window for resetting the
DCH (Active) timer (sec)
DCH (Active) timer (in seconds).
RLC consumption rate (^2) for The RLC consumption rate (^2) for
uplink
uplink.
RLC consumption rate (^1) for
uplink
RLC consumption rate (^0) for
uplink
RLC consumption rate (^2) for
downlink
RLC consumption rate (^1) for
downlink

The RLC consumption rate (^1) for
uplink.
The RLC consumption rate (^0) for
uplink.
The RLC consumption rate (^2) for
downlink.
The RLC consumption rate (^1) for
downlink.

RLC consumption rate (^0) for The RLC consumption rate (^0) for
downlink
downlink.
Time delta for throughput
calculations (sec)
Threshold for defining a burst
(sec)
Threshold for defining a long
burst (sec)

The time delta (in seconds) used for
calculating throughput.
The time threshold (in seconds) used for
defining a burst.
The time threshold (in seconds) used for
defining a long burst.
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Network Attribute

Description

Threshold for user input
window (sec)
Periodical Transfer Analysis Min size of periodical clusters
(sec)

The time threshold (in seconds) used for
calculating user input.
The minimum size (in seconds) of a
cluster of periodical transfers.

Periodical Transfer Analysis Max tolerable variation for
periodical transfers (sec)
Periodical Transfer Analysis Min number of periodical
transfers
Threshold for duration of a
large burst (sec)

The maximum tolerable variation (in
seconds) used for calculating periodical
transfers.
The minimum number of periodical
transfers.

Threshold for size of a large
burst (bytes)
Threshold for close spaced
bursts (sec)

The size threshold (in bytes) used for
defining a large burst.
The threshold (in seconds) used for
defining a close spaced burst.

The duration threshold (in seconds)
used for defining a large burst.

The following device attributes are defined for the AT&T 3G profile.
Device
Description
Attribute
Device Name
The make and model of the device.
DCH (Active)
Power (w)

The amount of power (in watts) that should be used
when the RRC state is DCH (Active).

FACH
The amount of power (in watts) that should be used
(Standby)
when the RRC state is FACH (Standby).
Power (w)
IDLE Power (w) The amount of power (in watts) that should be used
when the RRC state is IDLE.
Average power
for IDLE->DCH
(Active)
promotion (w)

The average amount of energy used when the RRC
state is promoted from IDLE to DCH (Active).

Average power The average amount of power (in watts) that should
for
be used when the RRC state is promoted from FACH
FACH
(Standby) to DCH (Active).
(Standby)>DCH
(Active)
promotion (w)

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

Device
Attribute
Average power
for active GPS
(w)

Description

Average power
for standby
GPS (w)

The average amount of power (in watts) for standby
GPS.

The average amount of power (in watts) for active
GPS.

Average power The average amount of power (in watts) when the
when camera is camera is on.
on (w)
Average power
for active
Bluetooth (w)

The average amount of power (in watts) for active
Bluetooth.

Average power
for standby
Bluetooth (w)

The average amount of power (in watts) for standby
Bluetooth.

Average power
when screen is
on (w)

The average amount of power (in watts) when the
screen is on.

iii.
iv.

AT&T LTE Profile Network and Device Attributes
The following network attributes are defined for the AT&T LTE profile.

Network
Attribute
Carrier

Description

Promotion time
from Idle to CR
(sec)
Time of
inactivity from
CR before
DRX (sec)

The amount of time (in seconds) spent in promotion
from the IDLE state to the CR state.

Time in short
DRX (sec)

The amount of time (in seconds) spent in the Short DRX
state.

The network carrier for the device.

The amount of inactive time (in seconds) spent in the CR
state before changing to the DRX state.
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Network
Description
Attribute
Ping
length The length of a ping (in seconds) during the DRX state.
during DRX
(sec)
Time in Long
DRX (sec)

The amount of time (in seconds) spent in the Long DRX
state.

Ping length in
IDLE (sec)
Period
between pings
DRX Short
(sec)
Period
between pings
DRX Long
(sec)
Period
between pings
IDLE (sec)

The length of a ping (in seconds) during the IDLE state.

Time delta for
throughput
calculations
(sec)
Threshold for
defining
a
burst (sec)
Threshold for
defining a long
burst (sec)
Threshold for
user
input
window (sec)
Min cycle for
periodical
transfers (sec)
Max tolerable
variation for
periodical
transfers (sec)
Min observed
samples for
periodical
transfers

The time delta (in seconds) used for calculating
throughput.

The length of the period between pings (in seconds) in
the Short DRX state.

The length of the period between pings (in seconds) in
the Long DRX state.

The length of the period between pings (in seconds) in
the IDLE state.

The time threshold (in seconds) used for defining a
burst.
The time threshold (in seconds) used for defining a long
burst.
The time threshold (in seconds) used for calculating user
input.
The minimum cycle time (in seconds) used for
calculating periodical transfers.
The maximum tolerable variation (in seconds) used for
calculating periodical transfers.

The minimum number of observed samples used for
calculating periodical transfers.
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Description
The duration threshold (in seconds) used for defining a
large burst.

The size threshold (in bytes) used for defining a large
burst.

The following device attributes are defined for the AT&T LTE profile.
Device
Description
Attribute
Device Name
The make and model of the device.
Average
power during
promotion (w)
Average
power of ping
during short
DRX (w)
Average
power of ping
during long
DRX (w)
Average
power during
tail (baseline)
(w)
Average
power of ping
in idle (w)
Multiplier for
throughput
upload energy
calc.
(mW/Mbps)

The average power (in watts) used during promotion.

Multiplier for
throughput
download
energy calc.
(mW/Mbps)

The multiplier used for download energy calculations,
expressed in mW/Mbps.

The average power (in watts) used by a ping in the
Short DRX state.

The average power (in watts) used by a ping in the
Long DRX state.

The average power baseline (in watts) used in a tail
state.

The average power (in watts) used by a ping in the
IDLE state.
The multiplier used for throughput energy calculations,
expressed in mW/Mbps.
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Device
Attribute
Baseline for
CR energy
(before
throughput
modifiers
added) (w)
Average
power for
active GPS (w)

Description

Average
power for
standby GPS
(w)
Average power
when camera
is on (w)

The average amount of power (in watts) for standby
GPS.

The baseline value (in watts) for energy used in the CR
state, before throughput modifiers are added.

The average amount of power (in watts) for active
GPS.

The average amount of power (in watts) when the
camera is on.

Average power The average amount of power (in watts) for active
for active
Bluetooth.
Bluetooth (w)
Average power The average amount of power (in watts) for standby
for standby
Bluetooth.
Bluetooth (w)
Average power The average amount of power (in watts) when the
when screen is screen is on.
on (w)

v.
vi.

AT&T WiFi Profile Network and Device Attributes
The following network attributes are defined for the AT&T WiFi profile.

Network
Attribute
Carrier

Description

WiFi tail time
(sec)
Time delta for
throughput
calculations
(sec)

The amount of time (in seconds) spent in promotion
from the IDLE state to the CR state.
The time delta (in seconds) used for calculating
throughput.

The network carrier for the device.
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defining
a
burst (sec)
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defining a long
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Threshold for
user
input
window (sec)
Min cycle for
periodical
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variation for
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Min observed
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periodical
transfers
Threshold for
duration of a
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The time threshold (in seconds) used for defining a
burst.
The time threshold (in seconds) used for defining a long
burst.
The time threshold (in seconds) used for calculating user
input.
The minimum cycle time (in seconds) used for
calculating periodical transfers.
The maximum tolerable variation (in seconds) used for
calculating periodical transfers.

The minimum number of observed samples used for
calculating periodical transfers.

The duration threshold (in seconds) used for defining a
large burst.

The size threshold (in bytes) used for defining a large
burst.

The following device attributes are defined for the AT&T WiFi profile.
Device
Description
Attribute
Device Name
The make and model of the device.
Average
power WiFi
connected (w)
Average
power WiFi
inactive (w)
Average
power for
active GPS
(w)

The amount of inactive time (in seconds) spent in the
CR state before changing to the DRX state.
The amount of time (in seconds) spent in the Short DRX
state.
The average amount of power (in watts) for active
GPS.
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Average
power for
standby GPS
(w)
Average
power when
camera is on
(w)
Average
power for
active
Bluetooth (w)

The average amount of power (in watts) for standby
GPS.

Average
power for
standby
Bluetooth (w)
Average
power when
screen is on
(w)

The average amount of power (in watts) for standby
Bluetooth.

The average amount of power (in watts) when the
camera is on.

The average amount of power (in watts) for active
Bluetooth.

The average amount of power (in watts) when the
screen is on.

5.1.4. Tools Menu
The Tools menu contains the following selections.
Selection
Description
PCAP File
Analysis

Opens Wireshark to access the Pcap file and displays the
trace results in the Video Optimizer Data Analyzer.

Time Range
Analysis

Displays the Time Range Analysis dialog box that allows
you to set a time range, reset the time range, start or cancel
the analysis, calculate the statistics for the time range,
analyze based on the applied filters for IPv4, IPv6, TCP,
UDP, and DNS for a specific time range, and display the
analysis results.
Html->Opens a Save As dialog box that allows you to export
the currently loaded trace data to a html file with the results
from the Best Practices tab.
Json-> Opens a Save As dialog box that allows you to export
the statistical and analytical data from the current trace to a
single json file.
Excel-> Exports the required trace information from the best
practices tab along with all the best practices test results.

Export Results

All three export files include details of the time range that is
currently active such as Average Total Throughput, Uplink
Bytes, Average Upload Throughput, Downlink Bytes, Average
Download Throughput.
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Selection

Export
Session data
Edit Metadata

Private Data
Tracking

Video
Parser Wizard

•

Description
The exported files having a default naming convention of
<Trace_Folder_Name>_best_practices_results)
This feature exports all the request response and packet view
results information of all the sessions in the TCP/UDP Flows
table
Opens the metadata window where the user can enter/edit
information about the trace such as - Trace storage,
Description, Trace Type, Target App, Application Producer,
Application Version, Sim, Network, Creator, and Trace notes.
This option is disabled if the user opens a PCAP file and
chooses not to retain the directory that is created during
opening of the file.
Opens a menu that allows you to set parameters for the
Video Optimizer to search for in the trace. This allows you to
find instances where private data is transmitted in an
unsecure way.
Default settings for analysis of streaming video files
downloaded during the trace. Settings can be overridden to
customize the data to the specific application.

Time Range Analysis

This feature allows you to set a time range, start or cancel the
analysis, analyze based on the applied filters for IPv4, IPv6, TCP, UDP,
and DNS for a specific time range, and display the analysis results.
Start and end times can be entered in seconds, minutes:seconds,
or hours:minutes:seconds format. If the time range entry is invalid,
an error message is displayed for the input time range format. The
data populated in the Results text area is selectable so that it can
be copied to another application for comparison & further analysis.
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User has the ability to filter based on the IPV4, and IPV6 packets and
further for TCP, UDP, and DNS for each of those options. All 5 boxes
are checked by default when a trace is loaded. The user can choose

a specific time range and analysis will be done based on applied
filters and time range.
The Calculate Statistics button performs the analysis on the
provided time range and filters. The statistics results are displayed
in the text area based on the network profile that has been selected
in Profile->Load.
The Reanalyze button reanalyzes the trace with the selected time
range and filter.
The Reset button resets the timestamp to the entire trace duration.
For a 3G Profile, you will see the following results in the Time
Range Analysis dialog box.

Result

Description

Payload
length

The length of the payload in bytes.

Total Bytes

The total number of bytes in the trace.

Uplink
Bytes
Downlink
Bytes
RRC
Energy
DCH Time

The total number of bytes of uplink data in the trace.
The total number of bytes of downlink data in the
trace.
The amount of energy used in joules.
The amount of time, in seconds, that was spent in
the DCH state.
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Maximum
Throughput

The maximum data throughput in kilobytes per
second.

Maximum
Uplink
Throughput
Maximum
Downlink
Throughput
Average
Throughput

The maximum uplink data throughput in kilobytes per
second.

Average
Uplink
Throughput
Average
Downlink
Throughput

The average uplink data throughput in kilobytes per
second.

The maximum downlink data throughput in kilobytes
per second.
The average data throughput in kilobytes per
second.

The average downlink data throughput in kilobytes
per second.

For an LTE Profile, you will see the following results in the
Time Range Analysis dialog box.

Result

Description

Payload
length

The length of the payload in bytes.

Total Bytes

The total number of bytes in the trace.

Uplink Bytes

The total number of bytes of uplink data in the
trace.
The total number of bytes of downlink data in the
trace.
The amount of energy used in joules.

Downlink
Bytes
RRC Energy
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Result

Description

LTE Time

The amount of time, in seconds, that was spent in
the Continuous Reception (CR) state.

Maximum
Throughput

The maximum data throughput in kilobytes per
second.

Maximum
Uplink
Throughput
Maximum
Downlink
Throughput
Average
Throughput

The maximum uplink data throughput in kilobytes
per second.

Average
Uplink
Throughput
Average
Downlink
Throughput

The average uplink data throughput in kilobytes
per second.

The maximum downlink data throughput in
kilobytes per second.
The average data throughput in kilobytes per
second.

The average downlink data throughput in kilobytes
per second.

For a WiFi Profile, you will see the following results in the Time
Range Analysis dialog box.

Result

Description

Payload
length

The length of the payload in bytes.

Total Bytes

The total number of bytes in the trace.

Uplink Bytes

The total number of bytes of uplink data in the trace.
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Downlink
Bytes
RRC Energy

The total number of bytes of downlink data in the trace.

WiFi Active
Time

The amount of time, in seconds, that was spent in the
WiFi Active state.

Maximum
Throughput

The maximum data throughput in kilobytes per second.

Maximum
Uplink
Throughput
Maximum
Downlink
Throughput
Average
Throughput

The maximum uplink data throughput in kilobytes per
second.

Average
Uplink
Throughput
Average
Downlink
Throughput

The average uplink data throughput in kilobytes per
second.

The amount of energy used in joules.

The maximum downlink data throughput in kilobytes
per second.
The average data throughput in kilobytes per second.

The average downlink data throughput in kilobytes per
second.

5.1.5. View Menu
The View menu contains the following selections.
Selection
Description
Show Video
Viewer
Select
Applications/IPs
Select Time
Range

Options

Opens a window that displays the video of the
activities carried out on the device while the trace
data was being collected.
Opens the Select Applications / IP Addresses
dialog box that allows you to select the application
and IP address that are included in the analysis.
Displays the Time Range Analysis dialog box that
allows you to set a time range, reset the time range,
start or cancel the analysis, calculate the statistics
for the time range, analyze based on the applied
filters for IPv4, IPv6, TCP, UDP, and DNS for a
specific time range, and display the analysis results.
Opens the View Options dialog box that allows you
to select the events and states that will be plotted in
the Diagnostics View chart
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Displaying a Video
i. The Video Viewer in Video Optimizer displays the video of the
activities carried out on the device while the trace data was being
collected.
ii. Select Show Video Viewer from the View menu.
iii. Play/Pause: Plays or pauses the video.

•

Selecting Applications and IP Addresses
i. Choose Select Applications/IPs from the View Menu.
ii. You can select individual applications from a table and assign colors to
them. Another table lets you do the same thing to individual IP
Addresses. The data from each selected application and IP Address is
included in the analysis. The colors that you assign are used to mark the
packet information for that specific application or IP Address on the
Diagnostics Chart.
iii. Click any of the rows in the Color column to select a color.
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Once a color is selected, the trace will be recalculated,
and all packets in the Diagnostics tab will be recolored
based on your selections.
iv. User has the ability to filter based on the IPV4, and IPV6 packets and
further for TCP, UDP, and DNS for each of those options. All 5 boxes are
checked by default when a trace is loaded. An error message is
displayed if a selection does not return any data –

•

Selecting a Time Range
You can set a new time range for the trace analysis. This
allows you to analyze a subset of the loaded trace. When you
set the new start and end times, all of the analysis data in the
Best Practices/Results, Overview, Diagnostics, and Statistics
Tabs will display information for only your selected time
range.
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1. Choose Select Time Range from the View menu.
2. Enter a Start time and End time for the trace analysis.
3. User has the ability to filter based on the IPV4, and
IPV6 packets and further for TCP, UDP, and DNS for each of
those options. All 5 boxes are checked by default when a
trace is loaded.
4. Click on Reanalyze to reanalyze the best practices with
the selected time range.
5. The Reset button resets the timestamp to the entire
trace length.
6. Calculate Statistics calculates throughput and data
statistics for the selected time range and displays it in the
Results section.
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Filter selections made in the TCP/UDP streams table (after the
refresh button has been clicked) will carry over to the Time
Range Analysis dialog. The Start time and End Time fields
reflect the time for the session/s. Time range analysis
calculation is based on this selection. Complete trace analysis
or individual stream analysis can be done as required.
•

Options
From File>View>Options list, you can determine what will be
plotted in the Diagnostics View chart. Default View and Video
View are two checkboxes at the bottom with preset views for
the diagnostic window. Video Optimizer allows 11 views at a
time.
1. Select Options from the View menu.
2. Select the events and states that you want to be plotted
in the Diagnostics View chart.
3. Click OK.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

See the Diagnostics Tab section for more
details on this menu.

5.1.6. Data Collector Menu
The Data Collector menu contains the following selections.
Selection

Description

Start Collector

Starts the Video Optimizer Data Collector.

Stop Collector

Stops the Video Optimizer Data Collector.

5.1.7. Help Menu
The Help menu contains the following selections.
Selection
Description
FAQ

Opens the default web browser and displays the Video
Optimizer FAQs web page.

User Guide

Opens the default web browser and displays the Video
Optimizer User Guide
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Support
Downloads

Learn More
About
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Displays a dialog box containing the license information
for the open source libraries and binaries that are
distributed within the Video Optimizer package.
Provides a link to log in to the AT&T Developer Program
and file a ticket with Video Optimizer Support.
Opens the default web browser and displays the Video
Optimizer Downloads web page that contains links for
downloading and installing the different types of Video
Optimizer.
Opens the default web browser and displays the Learn
More about Video Optimizer web page.
Displays a dialog box containing information about the
Video Optimizer application including its version.

Content Tabs
The Video Optimizer user interface is divided into the following tabbed
sections.
Tab
Description
Best Practices /
Results

Displays the results of the Best Practices tests that are
conducted on the trace data.

Overview

Displays charts and tables that present an overview of
key statistical data from the trace.
Displays charts and tables that present key diagnostic
data from the trace.
Displays throughput chart, Movie Streams and Video
Requests.
Displays charts and tables that present key statistical
data from the trace.
Displays a waterfall view chart of the TCP connections
from the trace spread over time. The details, requests,
and responses of each connection can be viewed when
the chart is clicked.

Diagnostics
Video
Statistics
Waterfall

5.2.1. Best Practices/Results Tab
The Best Practices/Results tab displays the results for all the Best
Practices tests that are conducted on the data captured in the trace
files.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

When trace files are loaded into Video Optimizer, the Best
Practices/Results tab displays the following test results.
•

A SUMMARY section with basic information about the
trace.

•

A TEST STATISTICS section with high-level test statistics
and ATTENUATOR Simulation section with attenuator
information.

•

Details of the trace collected as entered by the user –
Trace storage, Description, Trace type, Device Orientation,
Targeted App, Application Producer, Trace source, Sim,
Network, Creator, and Trace notes.

•

A TESTS CONDUCTED section that lists all the tests and
has a basic pass/fail/warning result indicated by a specific
icon.

•

High-level results pages for all the tests grouped into the
test categories: File Download, Connections, HTML,
Security, Video, and Others.
Each of these pages has a common header panel that
shows the following information about the loaded trace files:
Label

Description

Date

The date when the trace files were generated.

Trace

The name of the folder containing the trace files.

Time Range

The time range description name followed by the
time range that is used to open the trace.
The names and versions of the applications that
were running when the trace data was collected.

Application
Name (s):
Version
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Label

Data
Collector
Version
Device
Make/Model
Display
Resolution
OS/Platform
Version
Network
Type(s)
Profile
Carrier
Name/Cell
ID
Secure

•

Description
Note: on iOS, application name and version are
not displayed. On Android 8 and above the
application names are not displayed.
The version of the Video Optimizer Data
Collector that was used to collect the trace data.
The make and model of the device from which
the data was collected.
The Orientation mode, and the Width and height
of the display from which the data was collected.
The operating system version or platform
version of the device that the trace was captured
on.
The types of any networks (such as 3G or LTE)
that were in use when the data was collected.
The device profile that was used for the trace
analysis.
Carrier name, and the Cell tower ID the device
was connected to when the trace was captured.
Option for true and false is displayed.

iPhone Make/Model
The iPhone make & model displayed by Video Optimizer is confusing to
many users. However, it is based on the manufacturer settings. Please
refer to the chart below to clarify iOS make & model.
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iOS device

VO displays

iOS device

iPhone1,1

iPhone

iPhone10,4

iPhone 8

iPhone1,2

iPhone 3G

iPhone10,5

iPhone 8 Plus

iPhone2,1

iPhone 3GS

iPhone10,3

iPhone X

iPhone3,1

iPhone 4

iPhone10,6

iPhone X
GSM

iPhone3,2

iPhone 4
GSM Rev A
iPhone 4
CDMA

iPhone11,2

iPhone XS

iPhone11,4

iPhone XS
Max

iPhone4,1

iPhone 4S

iPhone11,6

iPhone XS
Max China

iPhone5,1

iPhone 5
(GSM)
iPhone 5
(GSM+CDMA)
iPhone 5C
(GSM)
iPhone 5C
(Global)

iPhone11,8

iPhone XR

iPhone12,1

iPhone 11

iPhone6,1

iPhone 5S
(GSM)

iPhone12,8

iPhone SE 2nd
Gen

iPhone6,2

iPhone13,1

iPhone 12 mini

iPhone7,1

iPhone 5S
(Global)
iPhone 6 Plus

iPhone13,2

iPhone 12

iPhone7,2

iPhone 6

iPhone13,3

iPhone 12 Pro

iPhone8,1

iPhone 6s

iPhone13,4

iPhone 12 Pro
Max

iPhone8,2

iPhone14,4

iPhone 13 mini

iPhone14,5

iPhone 13

iPhone14,2

iPhone 13 Pro

iPhone9,1

iPhone 6s
Plus
iPhone SE
(GSM+CDMA)
iPhone SE
(GSM)
iPhone 7

iPhone14,3

iPhone 13 Pro
Max

iPhone9,2

iPhone 7 Plus

iPhone14,6

iPhone SE 3rd
Gen

iPhone9,3

iPhone 7

iPhone14,7

iPhone 14

iPhone9,4

iPhone 7 Plus

iPhone14,8

iPhone 14
Plus

VO displays

iPhone3,3

iPhone5,2
iPhone5,3
iPhone5,4

iPhone8,3
iPhone8,4

iPhone 11 Pro
iPhone12,3
iPhone12,5

iPhone 11 Pro
Max
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iPhone10,1

iPhone 8

iPhone15,2

iPhone 14 Pro

iPhone10,2

iPhone 8 Plus

iPhone15,3

iPhone 14 Pro
Max

iPhone10,3

iPhone X
Global

Summary
The Summary section shows the summary of results for all
the best practices tests conducted on the loaded trace files. It
contains the following sections.
TEST STATISTICS shows the following information about the
loaded trace files.
Label
Description
Duration

The total time, in minutes, for which the trace data
was collected.

Total Data
The total size, in bytes, of all data packets that are
Transferred transferred for the entire duration of the trace data
collection. This total includes the size of the
packet and the packet header.
Total
This gives the total payload of the entire traffic.
Payload
Data
Energy
The total energy, in Joules, that is consumed
Consumed during the entire duration of the trace data
collection. This total includes the energy of RRC,
GPS, WiFi, Bluetooth, Camera and Screen.

ATTENUATOR shows the parameters that were used for
network attenuation during collection. For example,
Downlink throttle provides the ms delay in the downlink
throttling, and uplink is the delay placed on uplink
connections. See Network Attenuation.
TESTS CONDUCTED displays a list of all the best practices
tests that were conducted on the loaded trace files with an
icon to the left of each test name that indicates the test
result status (Pass, Fail, Warning, Configuration required
and no data(N/A) icon.
The tests are grouped into the following categories.
Note: When any of the best practice tests in a category fails,
the header for that category turns red. The category header
remains green if all the tests in that category have passed.
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Test

Category

Description

Text File
Compression

File Download

Tests if any text files sent by
the app that were larger than
850 bytes are uncompressed.

Duplicate
Content

File Download

Tests if more than three files
are downloaded in a duplicate
manner in the loaded trace
files.

Cache
Control

File Download

Content
Expiration

File Download

Combine
Java Script
and CSS
Requests

File Download

Tests if the amount of “not
expired duplicate data” is
greater than the amount of
“not changed data” in the
loaded trace files.
Tests if there is more than
10% of non-cacheable data
available in the loaded trace
files.
Tests if there are multiple
requests for CSS or JS files
occurring within 2 seconds of
one another.

Resize
Images for
Mobile

File Download

Tests if there are any images
that are 150% larger than the
area specified for them.

Image
Metadata

File Download

Image
Compression

File Download

Tests for EXIF text metadata
in your images. An image fails
if the file is more than 1%
metadata.
Tests JPEG images for
compression. If a file is saved
at 85% quality and is >15%
smaller (in KB), the best
practice fails.
Alternative image formats can
help increase the speed of
your mobile application, as
newer compression
algorithms compress the files
to a much smaller size, with
virtually no loss in quality.

Image Format File Download
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Test

Category

Description

Image
Comparison

File Download

Minify CSS,
JS, and
HTML

File Download

Use CSS
Sprites for
Images

File Download

Connection
Opening

Connections

Unnecessary
Connections
– Multiple
Simultaneous
Connections
Multiple
Simultaneous
Connections
to One
Endpoint

Connections

Images downloaded from the
network should be
approximately the same size
as the images that appear on
the screen. Video Optimizer
measures each image on the
screen and compares the
dimensions to the images
downloaded over the network.
Tests if there are any files that
could be minified (shrunk
through the removal of
whitespace).
Tests for any groups of small
images that are downloaded at
once, which could be
combined into one image
using sprites.
This test helps ensure
connections are opened
properly. Some connection
startups consist of an input
burst, followed by a series of
bursts spread out over time
which can dramatically slow
down the application's
response time and waste
energy on the device. This is a
self test.
Tests if there are several
bursts in a row that are not
user initiated in the loaded
trace files.

Connections

With HTTP2, you can utilize
multiplexing – to download
multiple
files
in
one
connection.
Using fewer
connections allows content to
be downloaded faster and
uses fewer resources on the
device.
The threshold is
increased to 7 or more
simultaneous connections to
same server.
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Test

Category

Description

Multiple
Simultaneous
Connections
to Many
Endpoints

Connections

Opening many connections all
at once can cause bottlenecks
in slower network conditions.
Android limits the number of
TCP connections to 15.

Inefficient
Connections
– Periodic
Transfers

Connections

Tests if a periodic connection
is detected in the loaded trace
files.

Inefficient
Connections
– Screen
Rotation
Inefficient
Connections
–
Connection
Closing
Problems
400,500
HTTP Status
Response
Codes

Connections

Tests if the application triggers
network activity when the
screen orientation changes.

Connections

Tests if 5% of the energy is
used for TCP control in the
loaded trace files.

Connections

301,302
HTTP Status
Response
Codes

Connections

Tests if there are any HTTP
response codes in the 400
range (indicating a client
request error) or in the 500
range (indicating a server
request error) in the loaded
trace files.
Tests if there are any
occurrences of the HTTP
status response code 301
(indicating that the URI of a
requested resource has been
changed permanently), and
any occurrences of the HTTP
status response code 302
(indicating that the URI of a
requested resource has been
changed temporarily) in the
loaded trace files...

3rd Party
Scripts

Connections

Tests for files where at least 2
external scripts are being
called.
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Test

Category

Asynchronous HTML
Load of
JavaScript in
HTML
Http 1.0
HTML
Usage
File Order

HTML

Empty
Source and
Link
Attributes
“display:
none” in CSS

HTML

Security:
HTTPS
Usage

Security

Transmission
of Private
Data
Unsecure
SSL Version

Security

Forward
Secrecy

Security

Stalls

Video

Start Up
Delay

Video

Buffer
Occupancy

Video

HTML

Security

Description
Tests for any HTML files with a
synchronous load of
JavaScript in the HEAD.
Tests if HTTP 1.0 is seen in
the header of the loaded trace
files.
Tests for any HTML files
where JS is loaded
immediately before CSS.
Tests for the empty attributes:
iframe src, href src, img src,
script src, and link href, in the
trace files.
Tests for any instances of the
CSS command
“display:none” in the trace
files.
Looks for connections that do
not feature HTTPS. The best
practice displays information
about Total HTTPS data, Total
HTTPS unanalyzed and % of
Total HTTPS Data.
Scans all transmitted data for
potential leaks of private data.
There are several versions of
SSL that are not considered
secure. This test identifies
connections that use those
versions.
Encryption that allows key
capture, allowing attackers to
gain access to all security
keys.
Identifies when a video stalls
(stops playing due to an empty
buffer).
Quantifies the time it takes for
video to start from the first
download of video data.
Quantifies the amount of
video stored in the buffer
over time.
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Test

Category

Description

Network
Comparison

Video

TCP
Connection

Video

Compares the video
bandwidth download with the
available network bandwidth,
to determine if the optimal
bitrate is being displayed.
Results section include
Declared Manifest(kbps) and
Calculated Network
Bitrate(Kbps) for each
segment.
Count of connections used to
deliver video during the trace.

Segment size

Video

Segment
Pacing

Video

Redundancy

Video

Concurrent
Session

Video

Variable
Bitrate

Video

Resolution
and
Perception

Video

Analyzing the
Adaptive
bitrate ladder

Video

Average size of the video
chunks downloaded during
streaming.
Pacing of the video chunks
downloaded during streaming.
Looks to see if the same
chunk is downloaded multiple
times.
Using too many concurrent
sessions may cause problems
with smooth delivery of content
Analysis for Non- DRM
stream.
Video Optimizer conducts a
test that flags video files with
resolutions greater than 720p
that are being sent to a
smartphone.
By analyzing your ABR Ladder
and designing it to stream files
more efficiently over HTTP
networks, with careful
consideration of device.
Results Section includes Track
#, Resolution, Playback %,
Segment Count, Total
Duration(Sec), Segment
Position(Sec), Declared
Bitrate(kbps), Average
Bitrate(Kbps)
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Test

Category

Description

Streaming
Separate
Audio and
Video

Video

Accessing
Peripheral
Applications

Others

Streaming Separate Audio and
Video segments, known as
demuxing, has a number of
benefits. There are also
challenges that can lead to
video stalling
Tests if any peripheral
applications are seen to be ON
for more than 5% of the total
duration recorded in the
loaded trace files. The
peripheral applications
checked during this test are:
GPS, WiFi, Bluetooth, and
camera.

For more detail on each of these best practices, visit
https://developer.att.com/video-optimizer/docs/best-practices.
•

Tables
The tables in the Video Optimizer best practices sections
help you pinpoint the issues flagged by the best practice and
they let you further investigate the issues. Double-click a line
in the Best Practices table to view the Diagnostics tab, which
highlights the connection or file that is failing the best
practice.
Right click a line in the Best Practices table to export the
table. (Alternatively, command-a (select all) command-c
(copy) will allow you to paste (command v) the table into
your favorite spreadsheet software). Export table feature has
a relevant default table name as file name - (Default
filename => <Trace_Folder_Name>_<table_name>). For
example, for best practices results export: Default filename
=> <Trace_Folder_Name>_<best_pratice_name>. The
<best_pratice_name> usually follows the naming convention
of best practice category and corresponding test name.
Images tables have additional features such as metadata
views.
1. Click an image table to open a content view with the
metadata:
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2. Click the file name or original file size columns in the Image
Compression table to open a view of the original image.
3. Click the 85% column to open the 85% compressed image
and click the 70% column to open the 70% compressed
image. In Figure, all three images are open in the Content
Viewer (the original image, the 85% compressed image, and
the 70% compressed image).

5.2.2. Overview Tab
The Overview Tab displays charts and tables that summarize the
data in the loaded trace files. The top part of the Overview tab
contains the following information:
• Date: The date when the trace files were generated.
• Trace: The name of the folder containing the trace files.
• Downlink Throttle: If the Network attenuator downlink function was
used during this trace, it will register the speed in mbps/kbps.
• Uplink Throttle: If Network Attenuator uplink function was used
during this trace, this will record the speed in mbps/kbps.
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• Network Type: The type of network, like 3G or LTE, which was in
use when the data was collected.
• Profile: The profile that was used for the trace analysis.
• Total Bytes: The total number of bytes in the trace
•

Charts
The top of the Overview tab has three charts with high level
information about the type of content, the energy usage
compared with benchmark traces, and the number and type
of connections used.
The File Types chart plots the percentage of the various file
types found in the trace data.

The Trace Benchmarking chart plots the average data rate,
energy efficiency, and signaling overhead of the loaded
trace, as a percentage, compared with a set of sample
benchmark traces.

The Connection Statistics chart plots the percentage of the
various types of session terminations based on the data
captured in the trace. Four types of session terminations are
plotted: Proper session termination, tightly grouped
connection, periodic bursts connection, and large burst
connection.
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The Connection Statistics chart contains the following fields:
Field
Description
Proper
If the amount of time between the last data packet and
session
the data packet that signaled the TCP session
termination termination is less than or equal to 1 sec, then the
session termination is represented as proper session
termination. In the session termination plot, the
sessions are displayed as a percentage of the total
number of TCP sessions.
Tightly
If 3 bursts occur in less than 15 seconds or 4 bursts
grouped
occur in less than 60 seconds, then those sets of bursts
connection are referred to a tightly grouped connection. In the
session termination plot, these bursts are displayed as
a percentage of the total number of bursts.
NonIf the Internet Addresses, host names, or object names
Periodic
are not the same for the packets in a set burst over a
Burst
period, then those bursts are considered nonperiodic
connection bursts. In the session termination plot, these bursts are
displayed as a percentage of the total number of bursts.
Large
If the burst duration is more than 5 seconds, then that
Burst
burst is considered a large burst. In the session
connection termination plot, these bursts are displayed as a
percentage of the total number of bursts.

•

Tables
The bottom section of the Overview tab has tables for the
accessed domains. You can get more information about
these items by clicking on table rows.
The Duplicate Content table lists files that have been
identified as duplicate content. By default, the table is sorted
by content type, and it includes the following columns.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

Column

Description

File Name

One of the following types of duplicate content:
ORIGINAL_FILE
OBJDUP_NOT_EXPIRED
OBJDUP_NOT_CHANGED_SERVER
OBJDUP_NOT_CHANGED_CLIENT
OBJDUP_PARTIAL_NOT_CHANGED_SERVER
OBJDUP_PARTIAL_NOT_CHANGED_CLIENT
OBJDUP_PARTIAL_NOT_EXPIRED
OBJDUP_DIFF_ETAG
The timestamp for this occurrence of the
duplicate content.
The name of the duplicate file.

File Size (bytes)

The size of the duplicate file in bytes.

Time

1. Click the title of any column to sort the table.
2. Select a file and click View or Save As to view or save the
content of the file.
3. Right-click the table to export the data. The default naming
convention for the exported file is
<Trace_Folder_Name>_overview_<table_name>
The Accessed Domains table contains details about each
domain that was accessed during the trace. The table
includes the following columns.
Column
Description
Domain Name

TCP Sessions
Average Session
Length (sec)

Files Downloaded

The list of domain names that are captured in
the loaded trace files. These domain names
are application independent and may have
occurred in the browser app or any other
application.
The count of TCP sessions for the
corresponding domain name.
The average session length in seconds. This
average is calculated by dividing the total
TCP session time (the difference between the
session end time and the session start time)
by the size of the session for this domain
name.
The number of files downloaded for the
domain name session.

1. Click the title of any column to sort the table.
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2. Left-click a domain in this table to populate the adjoining
table (Domain TCP Sessions) with information about the TCP
sessions that were used when accessing that domain.
3. Right-click the table to export the data in preferred format.
The default naming convention for the exported file is
<Trace_Folder_Name>_overview_accessed_domains.
The Domain TCP Sessions table contains the collection of
TCP Session information for the currently selected domain
name in the Accessed Domains table and refreshes each
time a new domain name is selected. The table includes the
following columns.
Column
Description
Time
Remote IP Address
Local Port
Session Length (sec)

Bytes Transmitted
Session Close Delay
(sec)
Closed By

The time stamp of the Domain TCP
Session.
The Remote IP Address of the
Domain TCP Session.
The Local port value of the Domain
TCP Session.
The session length, in seconds, of
the Domain TCP Session. The
session length is the difference
between the starting time stamp
and the ending time stamp for the
session.
The number of bytes transmitted
during the Domain TCP session.
The session termination delay, in
seconds, of the Domain TCP
Session.
Indicates whether the Client or the
Server closed the
Domain TCP Session. The Closed
By value can be Client, Server, or
Status Unknown, and is
determined by the session packet
direction.

1. Click the title of any column to sort the table.
2. Double-click a domain in this table to navigate to the
TCP/UDP Flows Table in the Diagnostics tab where you can
view the TCP flow information for the selected Domain TCP
session. The selected TCP information will be indicated by
highlighted type.
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3. Right-click the table to export the data in preferred format.
The default naming convention for the exported file is
<Trace_Folder_Name>_overview_ domain_tcp_sessions.

5.2.3. Diagnostic Tab
The Diagnostics tab plots data from the loaded trace files and
displays it in a Diagnostics chart. Detailed information is displayed in
the TCP/UDP Streams Table, which has additional tabs for three
different views into the TCP or UDP data.

The Diagnostics tab displays the following information at the top
before the chart:
•

Date: The date when the trace files were generated.

•

Trace: The name of the folder containing the trace files.

•

Downlink Throttle: If the Network attenuator downlink function was
used during this trace, it will register the ms delay.

•

Uplink Throttle: If Network Attenuator uplink function was used during
this trace, this will record the ms delay uplink.

•

Total Bytes: The total number of bytes in the trace.

•

Network type: The type of network, like 3G or LTE, which was in use
when the data was collected.

•

Profile: The profile that was used for the trace analysis.
•

Diagnostics Tab Chart
The Diagnostics tab chart displays the graph data with an Xaxis for the trace timeline and a Y-axis for labels of the
information that is being plotted.
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or

•

Click

•

Click
to save a snapshot of the chart. The File
name field is populated with tracename_img by default
in the Save dialog box. The location chosen by default
is the trace folder.
Choosing a resolution from the drop down helps change
the time resolution of the graphs displayed. On hover
over the icon, a dialog informs the user that the graphs
can change based on the setting. The default resolution
is set to 1s

•

for a zoom view.

Changing the resolution does not reload the trace and
all relevant graphs use the same resolution settings.
The chosen resolution persists across trace loads and
Video Optimizer restarts.
Use the following procedure to configure the items that are
plotted on the Diagnostics tab chart.
1. Select Options from the View menu.
2. Select the items to be plotted in the View Options dialog
3. Click OK.
4. Move the pointer over the graphed items in the Diagnostics
tab chart for more information on each one.
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Note: In addition to creating your own custom view, there is a
Default View and a Video View – especially created to help
analyze video traces.
•

Diagnostics Tab Chart Items
The following sections describe in detail the different types of
information that can be plotted on the Diagnostics tab chart.
•

GPS State— shows the variation in GPS states over the
duration of the trace.
GPS State
Description
GPS Active
The GPS receiver is turned on and is fixing
the location. Energy consumption during this
state is high. This state is colored green in the
plot.
GPS
The GPS receiver is turned on but is in
Standby
standby mode. Energy consumption during
this state is low. This state is colored yellow in
the plot.
GPS Off
The GPS receiver is turned off.
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•

Signal Strength—shows the variation in radio signal strength
(expressed in Dbm) over the duration of the trace.

•

Bluetooth State—shows the variation in Bluetooth states over
the duration of the trace.
Bluetooth State
Bluetooth Connected

Bluetooth Standby

Bluetooth Off

•

Camera State—shows the variation in camera states over the
duration of the trace
Camera State
Camera On

Camera Off

•

Description
The Bluetooth is turned on and the
device is paired with another device
for data transfer. Energy
consumption during this state is high.
This state is colored green in the
plot.
The Bluetooth is turned on, but the
device is not paired with another
device. Energy consumption during
this state is low. This state is colored
yellow in the plot.
The Bluetooth is turned off.

Description
The Camera is turned on. Energy
consumption during this state is high. This
state is colored green in the plot.
The Camera is turned off.

Screen State—shows the variation in screen states over the
duration of the trace.
Screen State
Screen On

Screen Off

Description
The Screen is active. Energy consumption
during this state is high. This state is
colored green in the plot. When you place
the tooltip over this state in the plot, the
screen time out value (in seconds) and the
brightness (in %) are displayed.
The device is in sleep mode.
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•

Battery State—shows the variation in battery level over the
duration of the trace. Includes battery level, battery
temperature, and battery connection status.

•

WiFi State—shows the variation in WiFi states over the
duration of the trace.
WiFi State
WiFi Connecting

WiFi Off

The device is trying to connect to
a WiFi network. Energy
consumption during this state is
high. This state is colored green
in the plot.
The device is connected to a WiFi
network. Energy consumption
during this state is high. This state
is colored green in the plot. In
addition to state detail, also
shows the Mac Address, Radio
Received Signal Strength
Indication (RSSI) and Service set
identifier (SSID).
The device is disconnecting from
a WiFi network. Energy
consumption during this state is
high. This state is colored green
in the plot.
The device is disconnected from
WiFi network. Energy
consumption during this state is
low. This state is colored yellow in
the plot.
A WiFi network was disconnected
unexpectedly. Energy
consumption during this state is
low. This state is colored yellow in
the plot.
WiFi is disabled in the device.

WiFi Unknown State

The WiFi is in an unknown state.

WiFi Connected

WiFi
Disconnecting

WiFi Standby

WiFi Suspended

•

Description

Throughput — shows the variation in network traffic
(expressed in kbps) over the duration of the trace. The higher
the throughput, the higher the energy consumption. The Y
axis displays values to help with analysis.
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•

Uplink Throughput (UL Throughput) — shows the variation in
uplink network traffic (expressed in kbps) over the duration of
the trace. The higher the throughput, the higher the energy
consumption. The Y axis displays values to help with
analysis.

•

Downlink Throughput (DL Throughput) — shows the variation
in downlink network traffic (expressed in kbps) over the
duration of the trace. The higher the throughput, the higher
the energy consumption. The Y axis displays values to help
with analysis.

•

Latency – each TCP session’s latency measurements
captured over the course of the trace is mapped and
displayed graphically in a horizontal band in the diagnostics
tab. Hovering over the points in the graph displays the Start
time, Latency, SYN time, and the SYNACK time.

•

Session Count- A graphic element added to the Diagnostics
Tab titled 'Session count'. Values will be from a count of
simultaneous sessions open at a given time. User will be able
to see how many sessions are open at each transition, using
the tool tip. A sharp rise in session count should allow user to
see in the TCP/UDP Flows section, exactly which sessions
were being connected to cause the sudden rise.
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•

Uplink Packets (Packets UL)—shows the packets that were
uploaded (uplinked) in the sessions over the duration of the
trace. Includes Packet Info, TCP, UDP, UDP/QUIC, DNS
Session Info.

•

Downlink Packets (Packets DL)—shows the packets that
were downloaded (down linked) in the sessions over the
duration of the trace. Includes Packet Info, TCP, UDP,
UDP/QUIC, DNS Session Info.

•

Bursts—shows the various types of bursts that occurred over
the duration of the trace. A burst consists of consecutive
packets transferred in a batch. Includes the burst type, a
message, the packet count, the total bytes, and the
throughput (in kbps).
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Burst Type
TcpControl

TcpLossRecoverOrDup

UserInput

Screen Rotation

App

SvrNetDelay

Large Burst

Periodical

Description
This category of burst is colored blue in
the chart plot, and displays the tooltip
message: ”TcpControl: Traffic that is
delayed from a previous burst.”
This category of burst is colored black in
the chart plot, and displays the tooltip
message: “TcpLossRecover:
Traffic that has been resent due to long
delay.”
This category of burst is colored green
in the chart plot and displays the tooltip
message: “User Input: Traffic initiated
after a User Input event.“
This category denotes a burst caused
by the rotation of the device. It displays
the following tooltip message: “Screen
Rotation: This traffic was initiated by a
rotation of the device”.
This category of burst is colored red in
the chart plot and displays the tooltip
message: “App: Traffic initiated by the
client.”
This category of burst is colored yellow
in the plot, and displays the tooltip
message: “SvrNetDelay: Traffic
initiated by the server.”
If a burst duration is more than 5
seconds, then that burst is considered
to be a long (or large) burst. This
category of burst is colored gray in the
chart plot, and displays the tooltip
message: “LargeBurst: Traffic in a large
burst (configurable in settings).” Note:
The tooltip refers to the fact that the
length and size thresholds for what is
considered to be a long/large burst can
be configured using the Customize
dialog in the Profile menu.
If the Internet Addresses, or the host
names, or object names are the same
for the packets in a set burst over a
period of time, then those bursts are
considered periodic bursts. This
category of burst is colored purple/pink
in the chart plot, and displays the tooltip
message: “Periodical: Traffic that has a
distinct periodic pattern.”
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Burst Type
User Defined

Description
These are user defined bursts. This
category of burst is colored magenta in
the chart plot.
This category denotes an unknown type
of burst.

Unknown

•

User Input—shows the various user input events that have
occurred over the duration of the trace including the
following:
SCREEN_LANDSCAPE->BLUE
SCREEN_PORTRAIT->RED
SCREEN_TOUCH - > GREEN
KEY_VOLUP ->DARK_GRAY
KEY_VOLDOWN -> MAGENTA
KEY_POWER ->YELLOW

•

RRC States—shows the variation in the Radio Resource
Control (RRC) states over the duration of the trace. The
states are determined by calculating the battery usage when
network packets are received.
Note: DCH stands for dedicated channel, FACH stands for
forward access channel, and CR stands for Continuous
Reception.
RRC State

Description

IDLE

Indicates the radio is off.

DCH (Active)

This state is colored yellow in the chart plot. It
indicates
that the radio is in a high data, high radio
energy, and high bandwidth mode which
allows maximum throughput.
This state is colored with a yellow cross hatch
pattern in the chart plot. It indicates that the
radio is in a high throughput, high bandwidth
state, but no packets are being sent.
This state is colored green in the chart plot. It
indicates that the radio is in low power state.
Signaling packets may be sent, but content
requires transition to DCH.

DCH TAIL

FACH (Standby)
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RRC State
FACH TAIL

PROMOTION
IDLE->DCH
(Active)
PROMOTION
FACH (Standby)>DCH (Active)

LTE IDLE
LTE
CONTINUOUS

LTE CR TAIL
LTE DRX SHORT

LTE DRX LONG

WIFI ACTIVE
WIFI TAIL
WIFI IDLE

•

Description
This state is colored with a green cross hatch
pattern in the chart plot. It indicates that the
radio is in a low power state with no traffic.
Transition from IDLE to DCH (Active) state.
This state is represented by a red triangle in
the chart plot. It indicates the radio switching
from off to a high-power state.
Transition from FACH (Standby) to DCH
(Active) state. This state is represented by a
red polygon in the chart plot. It indicates
switching from low power state to the highpower state.
Indicates that the radio is in an idle state, with
occasional pings to the network for data.
Continuous Reception is the time of active
packet transfer. High throughput high energy
data transfer. Energy here is indicated as
constant, but it does vary based on
throughput.
Continuous Reception Tail is the inactivity
timer after packets are sent, prior to DRX.
The Short DRX state indicates that the radio
is in a high bandwidth, high energy state,
looking for packets.
The Long DRX state is the LTE Tail. It
indicates that the radio is in a high bandwidth,
high energy state, looking for packets.
The WiFi transmitter is at full power - sending
and receiving information.
The WiFi Tail state is an inactivity timer after
packets are sent.
The Radio is in an idle state, with a small
trickle of power usage

Network Type—indicates how long the device has been
connected to a particular network type, or if the network type
has changed during the trace. The network types that are
identified include GPRS, UMTS, HSDPA, HSPA, HSPAP,
HSUPA, Wi-fi, and LTE. For 5G, the following will the
displayed
o

OVERRIDE_NETWORK_TYPE_LTE_ADVANCED
_PRO ->Advanced pro LTE (5Ge)
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o
o

OVERRIDE_NETWORK_TYPE_NR_NSA -> NR
(5G) -> 5G Sub-6 networks
OVERRIDE_NETWORK_TYPE_NR_NSA_MMWA
VE -> (5G+/5G UW) -> 5G mmWave networks

•

Wakelock State—indicates whether the device is in the wake
state (active for user input) or the lock state during the trace.
Includes the number of times the wakelock state has been
changed from the plot point to the beginning of the trace.

•

CPU Usage—shows the total percentage of CPU usage for
each process followed by the name of each selected process
and the percentage of CPU that it is using (Figure). Although
the CPU Usage percentages for all the processes can be
viewed at once, this chart is most useful when only one
process is selected or when a small number of processes are
selected, because the changes between the data points is
more clearly visible.

Note: It is possible that the percentages for individual
processes may not always add up to the total percentage.
This is because the process called top is a command that
pulls the information from different locations that may not be
completely in sync.
•

Alarm Triggered—indicates when an application has
triggered an alarm. Includes the type and timestamp of the
alarm, the name of the application that triggered it, and the
number of times it repeated.

•

Buffer Occupancy—provides an estimate on how much video
(in KB) has been downloaded into the buffer. This line is
populated after the video chunk startup is calculated (see
Video analysis section for details).

•

Video Chunks—displays the first frame of each chunk (for
videos without DRM) to indicate when the chunk download
started. If the chunk has DRM, or Video Optimizer cannot
parse the first frame, a placeholder image will be displayed.
1. Click a chunk thumbnail to open a dialog to “match” the
screenshot with the time it appears in the video (see
video analysis section for details).
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2. Once the video has been matched with the screen video,
point to a video frame to display information about the
video playback.
•

Playback Buffer Occupancy—provides an estimate on how
much video (in seconds) is stored in the buffer. This line is
populated after the video chunk startup is calculated (see
Video analysis section for details).

•

CPU Temperature – displays the temperature of the device
for Android captures. The CPU temperature is captured
every 5 seconds and plotted.

The chart also displays the thermal events that have
occurred over the duration of the trace, indicating where the
device may have overheated and throttled. The functionality
is available only for devices running Android 10 or above.
Thermal mitigation has become increasingly important and is
needed when a device starts to overheat.
•
•
•
•
•
•
•

NO throttling -> Green color
LIGHT throttling -> Blue color-> UX isn't impacted.
MODERATE throttling ->Yellow color -> UX isn't greatly
impacted.
SEVERE throttling ->Magenta color -> UX is largely
impacted.
CRITICAL ->Red color ->Platform has done everything
to reduce power.
EMERGENCY -> Purple color -> Key components in
the platform are shutting down due to thermal
conditions.
SHUTDOWN -> Black color -> Shutdown immediately.
Please refer to the link below for additional information https://source.android.com/devices/architecture/hidl/ther
mal-mitigation

The thermal status is displayed on the device during trace
collection –
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Diagnostics Tab Tables
The TCP/UDP Streams table in the Diagnostics tab has rows
of TCP or UDP session data that correspond to trace points
in the Diagnostics chart.
1. Select or deselect the rows of TCP or UDP data and click on
the Refresh button next to the TCP/UDP Streams table to
narrow the trace data that appears in the Diagnostics chart.

2. Click the check box in the title row to select or deselect all of
the TCP and UDP data.
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The TCP/UDP Streams table contains the following columns
of information:
Column

Description

Time

Byte Count

The amount of time (in seconds) from the
beginning of the trace, when this request was
made.
The name of the domain to which the request
is being made. The field is populated using a
reverse DNS lookup of the session’s remote
IP.
The local port through which the request is
being made
List all the remote IP server addresses.
Support for IPV4 and IPV6. Supports parsing
IPV6 headers and all different formats of IPV6
representations.
The number of the remote port (on the
domain) through which the request is being
received.
The number of bytes in the TCP/UDP Stream.

Packet Count

The number of packets in the request.

Protocol

Indicates whether the TCP or UDP or QUIC or
DNS protocol was used.
RTT time is calculated by SYNC and ASYNC
time displayed in the Packet view. The
calculated value is displayed in the TCP/UDP
streams.

Domain Name

Local port
Remote Ip

Remote Port

RTT(Round
Trip Time)

Note – Additional functionality – double clicking on the session
will bring up a dialog box. The SNI is populated for TCP, and
UDP/QUIC sessions where the data is available. This data is
select-able for copying, but not editable.

A second table below the TCP/UDP Streams table has tabs
that let you change the data view in four different ways:
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Request/Response (default view), Packet, Content View and
Delay.
The Request/Response View tab displays the
request/responses associated with the selected row highlighted
in the TCP/UDP Streams Table.

Column headings in the Request/Response View have different
meanings (separate by a “/” in the column name) depending on
whether the row contains a request or a response.
Column

Description

Time

The time of the request or response, in seconds, from
the beginning of the trace.

Direction

The direction of the TCP stream (REQUEST or
RESPONSE)
Req
HTTP request type (GET, PUT, POST, or DELETE) or
Type/Status
the HTTP status of the response (such as 200 for OK
or 404 for resource not found).
Host
The host name for the HTTP request or the content
Name/Content type of the response. Content type consists of a pair
Type
of values (type/subtype) representing the Internet
media type, for example, text/plain (simple text
messages), text/html (HTML document), text/CSS
(cascading style sheet), image/gif (GIF Image),
image/jpeg (JPEG Image), application/JSON (JSON
data object).
Object
The name of the object requested from the host or the
Name/Content length, in bytes, of the response.
Length
On Wire
The number of bytes on the wire during this request or
response.
HTTP
Compression

This column is only used for responses with a text
MIME type. If the response contains a text file, this
column indicates if HTTP compression was used or if
there was none. BR and gzip Compression are
triggered under HTTP Compression.

1.
Select one of the rows from the Request/Response
View tab that has a response.
2.
Click View to display the data object in the response.
For an image, the image will be displayed in the Content viewer
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(Figure). If the data object is text, HTML, or JSON it will be
displayed in the Content viewer (Figure).
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3. Click Save As to save the object as a file in the specified
directory.
(Note that the View and Save As buttons are not available
for Requests).

If the object cannot be displayed, an error message will
indicate that the content was unable to be viewed because it
may be corrupted.
The Packet View tab shows information about the individual
packets associated with the selected TCP or UDP stream
(Figure).
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The following table describes the columns of data in the Packet
View tab.
Column

Description

ID

An integer value that uniquely identifies each packet
within the trace.

Time

The time, in seconds, from the beginning of the trace

Direction

The packet direction. One of the following values:
UPLINK (The packet is sent up to the server),
DOWNLINK (The packet is sent down from the
server/host), UNKNOWN (The packet direction
cannot be determined).
Indicates the type of packet. One of the following
values: OPEN_CONN (A packet that opens a
connection), ACK (An acknowledgement packet),
DATA (A data packet).
The length of the payload (the data being sent in the
packet) in bytes.

Type

Payload
Length
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TCP Flags

Each letter in this field represents a different TCP
flag associated with the packet. More than one flag
can be associated with a packet. The possible flags
are: AS - Ack; P - Push; R - Reset, S - Synchronize,
F - Finish/End, E - Echo, U - Urgent, C - Congestion
Windows Reduced.

The Content View tab displays the content of the HTTP
request/response (Figure). All Request and Responses will
show in the same order as in Request/Response View. It has
a Search field to the right of the content window, in which you
can enter a search string. All instances of the string will be
highlighted in the content window and the Find Next button can
be used to navigate through the instances. The Content view is
not editable.

Delay: Display the delay associated with a response corresponding to
each request in a trace. Below screenshot displays the fields added:

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

Column

Description

Request Time
stamp

This field represents the timestamp of the
first TCP_DATA packet in a given request

First Packet
Arrival Time

This field represents the timestamp of the
first TCP_DATA packet in a corresponding
response.
Difference between the First Packet Arrival
Time and the Request Time stamp

First Packet delay

Last Packet
Arrival Time

This field represents the timestamp of the
last TCP_DATA packet in a corresponding
response

Last Packet delay

Difference between the Last Packet Arrival
Time and the Request Time stamp

Content Length

Displays the size of the response in bytes

Export TCP/UDP: Right click on the tcp/udp table to export the table. All
the columns including the SYN and SYN ACK Times for the Round Trip
Time are exported to an excel file and saved by default in Trace Folder
location. The default naming convention for the exported file is
<Trace_Folder_Name>_diagnostics_tcp_udp_streams.

5.2.4. Video Tab
The Video tab breaks down the video usage during the data
collection. This feature helps you understand how your
application downloads video. If you have a trace with video
collected, you will see this tab populated with Segment
Throughput graph, Segment Progress graph, Segment Buffer
graph, Video Stream, and Video Requests.
•

Segment Throughput graph:
This graph is enabled when at least one stream is selected in the
case where there are multiple streams present. However, if the
trace has only one stream then the graph is displayed as soon as
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the user loads the trace. Based on the type of stream that has
both audio/video or Muxed, the graph will be displayed with the
headers below.
Audio/Video Stream Segment Throughput graph:

Muxed Stream Segment Throughput graph:

•

Stream Examples
If Video Optimizer can read the movie stream, it will break
down the observed videos into tables.

Click the arrow
for one of the Streams to expand the
Audio/ Video segments table with each segment that is
observed from that Stream.

Figure above shows that Audio/Video segment number from
0-19 in Video and 0-20 in Audio. In the table, Segment
number 0 was downloaded with Audio Track 0 and Video
Track 2. When user double clicks on any of the segment row
then user will be taken to diagnostic tab.
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When audio and video are sent separate from each other
(demuxed) there will be separate tables for video & audio.
You can view partial details of video & audio side by side or

uncheck one or the other to see full details.
Export: Clicking on Export, exports the details of all the streams. The
exported data is saved in .xlsx file. The default naming convention for
the file is <Trace_Folder_Name>_video_streams. In the file, the first
column of the first line will be "Name" and the second column of the first
line will be the actual "Stream Name". The sheet names will correspond
to Stream numbers like Stream 1, Stream 2, and so on. For CSV export,
"Stream<Number>" is added on the line above the Stream Name. In the
case of Video, and Audio tables present for a stream, the excel sheet
displays the Video table information above the Audio table information.
In the case of Muxed video, the information is displayed under the video
table.

You may see a message indicating Video Optimizer observed
a gap in the segments, based on one or more missing
records in the list of sequential segments. This message is
primarily informational. There are many reasons a gap may
have occurred, and it might not signal a problem. Refer to the
screen shot below.

Audio Segments:
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Video Segments:

MUXED(Audio/Video):

The Diagnostics tab reveals that the segments from Figure
are not actually movie segments, but an entire Mp4 video
advertisement.

This ad was downloaded twice during the trace (possibly due
to slow network connectivity). A full 3 MB file that is
downloaded twice can add significant delay to the end user
(and it does appear as a failure in the duplicate file best
practice). Video Optimizer uses the Stream and a URL
parsing method to retrieve the values that are displayed in
the Video tab.
•

Video Request Examples
The last chart in the Video tab, Video Requests, is a list of all
the URLs that are used in video requests:
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Click on any of these video requests to open the Video
Parser Wizard, a tool to aid in the parsing of the video
segments – for any video segment that might not be
appearing properly in the Stream chart.
•

Video Parser Wizard

The Wizard uses regular expressions (regex) to find
parameters in the URL, request and response headers in
order to properly display each segment in the Stream chart.
In Figure, Video Optimizer is using a configuration called
uverse-YouTube to dissect the segment parameters. It gets
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most of the information, although you could argue that the
segment numbers are not totally accurate. Currently, Video
Optimizer only requires the following parameters to perform
video analysis:
•

Video ID

•

Segment number

•

Quality

•
Extension
One of the advantages of the Video Wizard is when you
have a video type that has not yet been profiled. For
example, the trace in Figure shows every segment
numbered as “-1”.

You can use the Video Parser Wizard to properly identify the
parameters in the URL and the headers by building a regular
expression to find them. For more information about using
regular expressions, see the following websites.
https://en.wikipedia.org/wiki/Regular_expression
http://www.regular-expressions.info/
For our purposes, we will cover a few important features:
Escaping: Special characters require a backslash to escape
them in a search. For example, if you want to denote a ‘/’
found in a url, you would write it as ‘\/’ to escape the
character.
Capture Groups: These are the parameters that we want to
“keep” for analysis. Capture groups are surrounded by
parentheses. (this\ is\ being\ captured) will grab a string “this
is being captured.” Note the escaped spaces.
With that – let’s dig into building the profile for this Stream.
Figure shows the request table of a trace that is not properly
profiled.
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The request table reveals that there might be two concurrent
streams – one for video, and the other for audio, so you
should create two profiles, starting with the “AEG” URL
(below).
http://dtvn-vodsponsored.akamaized.net/seg/vol2/s/AEG_CP/hpdt0000000000939227/
201611-21-18-4329/HPDM0000000000939227/AEG_01_128/AEG_01_128_00667.ts

The beginning of the URL shows that it is coming from
Akamai, and that it is from DTVnow, VOD “video on
demand”. While this is useful information, skip it for now.
1. Highlight the URL, select Match, and click Enter to see a
regular expression appear for that term. If you also select
Keep, the Wizard will add the capture group (more on this
later).

2. The next term in the URL is hpdt0000000000939227. This is
probably the unique string for the video stream. Since it has
both letters and numbers (and will change across videos,
select Match, keep (put in a capture group), and Alpha and
Numeric
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3. Click Enter to see the new regular expression (red box in
Figure) and because it is a capture group, there is a new
string in the Result field (orange box). This means that you
have successfully captured your first parameter.
4. Right-click on “unknown” in the Result field – so that you can
apply and add the XREF – in this case “ID” might be a good
choice for your XREF.
5. Notice the date in the URL (after the next /). Add “\/” to the
regular expression which means, stop at the next forward
slash.
6. To apply the date, add a search for numeric (d+), but this
will only get to the first dash (the result only shows 2016).
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7. Manually edit the added capture group from (d+) to ([\d+\-]*)
to look for digits or dashes, and the correct string is
populated (Figure).

After the next forward slash, there is another instance of the
ID (with capital letters this time), so add “\/([a-zA-Z0-9\_\]*)\/” to the regex to find this string.
Now you come to the part where the two URL types are
different (AEG and AUD)—and you must ensure that the
regular expression you create will only work for the URL in
question.
To find the AEG_01_128 files:
1.

Match & Keep on the String AEG.

2.

Add \_ to pass the underscore.

3.

Add Keep and Numeric to find 01.

4.

Add \_ to pass the underscore.

5.

Add Keep and Numeric for the 128.

6.

The regular expression appears as (AEG)\_(\d+)\_(\d+) 7.
Apply Quality to 128, and Bitrate to 128.
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After the next “/”, the same terms reappear, followed by
the segment number, a period and the extension. The
regex looks like the following:
(AEG)\_(\d+)\_(\d+)\_(\d+)\.([a-zA-Z0-9\_\-]*) The final
view of the Wizard is displayed:

8. Save this file, and then reload the trace to apply this JSON
profile to the video.
To find the AUD files:
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1. Modify the same regex to find the AUD files (All AEG -> AUD,
and the first (/d+) to (eng) were the only changes), for
example:
http\:\/\/dtvn\-vod\sponsored\.akamaized\.net\/seg\/vol2\/s\/AEG\_CP\/([a-zAZ09\_\-]*)\/([\d+\-]*)\/([a-zA-Z0-9\_\]*)\/(AUD)\_(eng)\_(\d+)\/(AUD)\_(eng)\_(\d+)\_(\d+)\.([a-zAZ0-9\_\-]*)

2. Reload the trace to see Stream files, one for the audio tracks,
and the other with the video tracks:

These two scripts will now parse any similar movie
segments in future traces of this mobile application.

5.2.5. Statistics Tab
The Statistics tab displays key statistical information based on the
analysis of the loaded trace. The information on the Statistics Tab is
divided into the following sections:
•

Header

•

TCP(Session) Statistics
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•

Attenuator Simulation

•

Endpoint Summary

•

RRC(Radio Resource Control) State Machine Simulation

•

Burst Analysis

•

HTTP Cache Statistics

•

Energy Efficiency Simulation
Export Button
The top right corner of the Statistics tab has an Export
button.

1. Click Export.
2. The default naming convention for the file is
<Trace_Folder_Name>_best_practices_results. Click Save
in the Save As dialog box to save all the data from the Best
Practices/Results tab as a .html file.
3. Click OK when the file has been saved or click Open to open
the file immediately. When you click Open, the export file will
be opened using the program that you have identified in
your OS as the default program for .html files.
•

Header Section
The Header section of the Statistics tab displays information
about the trace that the statistics are derived from. The
information in the Header section is the same as in the
header of the Best Practices/Results tab.
The following table describes the information displayed in the
Header section:
Label
Date
Trace
Time Range

Description
The date when the trace files were
generated.
The name of the folder containing the
trace files.
The time range description name
followed by the time range that is used
to open the trace.
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Label
Application(s) Name:
Version
Data Collector Version

Device make/model
Display Resolution

OS/Platform Version

Network type

Carrier Name/Cell ID

Profile
Secure

•

Description
The names and versions of the
applications that were running when
the trace data was collected.
The version of the Video Optimizer
Data Collector that was used to collect
the trace data.
The make and model of the device
from which the data was collected.
The Orientation mode, and the Width
and height of the display from which
the data was collected.
The operating system version or
platform version of the device that the
trace was captured on.
The type of network, like 3G or LTE,
which was in use when the data was
collected.
Carrier name, and the Cell tower ID
the device was connected to when the
trace was captured.
The device profile that was used for
the trace analysis.
True for a secure trace and False for
non-secure traces.

TCP (Session) Statistics
The TCP (Session) Statistics section of the Statistics Tab
information page provides overall statistics about the TCP
Packet information captured in the loaded trace files. The
minimum, maximum, and average values for the captured
latency measurements are displayed. The values are
calculated only for sessions where session based latency is
available.

The following table describes the statistics contained in the
TCP (Session) Statistics section:
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Field

Description

Duration of the
packets analyzed
(sec)

The time difference, in seconds, between the last packet
time stamp and the first packet time stamp in the loaded
trace.

Total Bytes

The sum of the packet length values from the loaded
trace. The packet length value includes both the header
length and the data length.

TCP Packet Count

The total number of tcp packets in the loaded trace.

Avg Rate (kbps)

The average transfer rate of data in kilobytes per
second. This value is derived from the total number of
transferred bytes and the trace duration.

Minimum Latency

Displays the minimum latency detected across all TCP
sessions in a trace.

Maximum Latency

Displays the maximum latency detected across all TCP
sessions in a trace.

Average Latency

Displays the average latency for all TCP sessions in a
trace.

•

ATTENUATOR Simulation

•

Endpoint Summary Section

The Endpoint Summary section of the Statistics Tab information page
contains two tables that summarize the packet information for each
application, and for each IP Address. These two tables are:
•

Endpoint Summary
Per Application

•

Endpoint Summary
Per IP Address

•

Endpoint Summary Per Application Table

The Endpoint Summary Per Application table summarizes the number
of packets, the total payload bytes, the percent of total payload bytes
in regards with the total bytes, and total number of bytes for each
application in the trace.
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The following table describes the statistics contained in the Endpoint
Summary Per Application table:
Column

Description

Application Name

The name of the application.

Packet Count

The total number of packets for this application.

Total Payload
Bytes
Percent

The total number of payload bytes for this application.

Total Bytes

•

The percent of total payload bytes in regards with the
total bytes for this application.
The total number of bytes for this application.

Endpoint Summary Per IP Address Table
The Endpoint Summary Per IP Address table summarizes the
number of packets, the total payload bytes, the percent of
total payload bytes in regards with the total bytes, and total
number of bytes for each IP address in the trace.

The following table describes the statistics contained in the
Endpoint Summary Per IP Address table:
Column

Description

IP Address

The IP Address.

Packet
Count
Total
Payload
Bytes

The total number of packets for this IP
address.
The total number of payload bytes for this IP
address.
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Percent
Total
Bytes
•

The percent of total payload bytes in regards
with the total bytes for this IP address.
The total number of bytes for this IP address.

RRC (Radio Resource Control) State Machine Simulation
The RRC (Radio Resource Control) State Machine
Simulation section of the Statistics Tab information page
displays an analysis of how much time was spent in the
various RRC states.
Note: The names of the RRC states and the information
displayed in this section depend on the type of device profile
that is selected (3G, LTE, or WiFi).
When a 3G device profile like AT&T 3G is selected, then the
section appears like the following:

The following table describes the statistics contained in the
RRC (Radio Resource Control) State Machine Simulation
section when a 3G device profile like AT&T 3G is selected:
Field
DCH
(Active)

Description
The amount of DCH (Active) state time, in seconds,
and its percentage of total packet duration.

FACH
(Standby)

The amount of FACH (Standby) state time, in
seconds, and its percentage of total packet
duration.
IDLE
The amount of IDLE state time, in seconds, and its
percentage of total packet duration.
IDLE→DCH The amount of time spent in promotion from the
(Active)
IDLE state to the DCH (Active) state, in seconds,
and its percentage of total packet duration.
FACH
The amount of time spent in promotion from the
(Standby)
FACH (Standby) state to the DCH (Active) state, in
→ DCH
seconds, and its percentage of total packet
(Active)
duration.
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Field
DCH
(Active) Tail
Ratio
FACH
(Standby)
Tail Ratio
Promotion
Ratio

Description
The ratio between the amount of DCH (Active) Tail
state time and the amount of DCH (Active) state
time.
The ratio between the amount of FACH (Standby)
Tail state time and the amount of FACH (Standby)
state time.
The ratio between the sums of the total promoted
RRC states time and the total packet duration. The
promoted RRC states are IDLE→DCH (Active) and
FACH (Standby) →DCH (Active).

When an LTE device profile like AT&T LTE is selected, then
the section appears like the following:

The following table describes the statistics contained in the
RRC (Radio Resource Control) State Machine Simulation
section when an LTE device profile is selected:
Field
IDLE>Continuous
Reception
Continuous
Reception
Continuous
Reception
Tail
Short DRX

Description
The amount of time spent in promotion from the
IDLE state to Continuous Reception, in
seconds, and its percentage of total packet
duration.
The amount of Continuous Reception state time, in
seconds, and its percentage of total packet
duration.
The amount of Continuous Reception Tail state
time, in seconds, and its percentage of total packet
duration.
The amount of Short DRX state time, in seconds,
and its percentage of total packet duration.

Long DRX

The amount of Long DRX state time, in seconds,
and its percentage of total packet duration.

IDLE

The amount of IDLE state time, in seconds, and its
percentage of total packet duration.
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Continuous
Reception
Tail
Ratio
Long DRX
Ratio
Short DRX
Ratio
Promotion
Ratio

The ratio between the amount of Continuous
Reception Tail state time and the amount of
Continuous Reception state time.
The ratio between the amount of Long DRX state
time and the amount of Continuous Reception and
Short DRX state time.
The ratio between the amount of Short DRX state
time and the amount of Continuous Reception and
Long DRX state time.
The ratio between the promoted state time
(IDLE→Continuous Reception), and the sum of the
IDLE, IDLE→Continuous Reception, Continuous
Reception, and Continuous Reception Tail state
times.

When a Wi-Fi device profile like AT&T Wi-Fi is selected, then
the section appears like the following:

The following table describes the statistics contained in the
RRC (Radio Resource Control) State Machine Simulation
section when a Wi-Fi device profile is selected:
Field

Description

Wi-Fi Active

The amount of Wi-Fi Active state time, in seconds,
and its percentage of total packet duration.

Wi-Fi Tail

The amount of Wi-Fi Tail state time, in seconds,
and its percentage of total packet duration.
The amount of Wi-Fi Idle state time, in seconds,
and its percentage of total packet duration.

Wi-Fi Idle

•

Burst Analysis Section
The Burst Analysis section of the Statistics Tab information
page, contains two tables that provide burst information. One
that groups the bursts by burst type, and another that lists
individual bursts. These two tables are:
•

Burst Analysis

•

Individual Burst Analysis
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Burst Analysis Table
The Burst Analysis table provides information about the
collected bursts from the loaded trace, summarized by burst
type. You can export the contents of this table in the
preferred format by right-clicking on it.
Note: The columns of information displayed in this table
depend on the type of device profile that is selected.
When a 3G device profile like AT&T 3G is selected, the
Burst Analysis table appears like the following:

When an LTE device profile like AT&T LTE is selected, the
Burst Analysis table appears like the following:

When a Wi-Fi device profile like AT&T Wi-Fi is selected, the
Burst Analysis table appears like the following:

The following table describes all the statistics contained in
the Burst Analysis table for all types of device profiles:
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Field
Burst

Description
One of the following Burst types according to
the request/response types in the loaded
trace.
Burst
Categories
TCP Control
TCP Loss
Recover
User Input
Screen
Rotation
App
SvrNetDelay
NonTarget
LargeBurst
Periodical
Unknown
Userdef 1
Userdef 2
Userdef 3

Bytes

% of Bytes

Energy
% of
Energy
DCH
(Active)

The payload length, in bytes, for the
corresponding Burst type. The payload length
considers only the data length of packets
which occurred during the burst.
The percentage of total payload used by the
individual burst payload. The total payload is
the sum of all burst payloads.
The amount of Energy, in Joules, for the
corresponding Burst type.
The percentage of total burst energy used by
the individual burst. Total burst energy is the
sum of all individual burst Energy amounts.
The amount of DCH Active time for the
corresponding Burst type. Note: This column
is only displayed when a 3G device profile is
selected.
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Field
%DCH
(Active)

Continuous
Reception

% of
Continuous
Reception

Wi-Fi
Active

% of Wi-Fi
Active

Jpkb

•

Description
The percentage of total DCH Time used by
the individual burst. The total DCH Time is the
sum of all individual burst DCH Times.
Note: This column is only displayed when a
3G device profile is selected.
The amount of Continuous Reception time for
the corresponding Burst type.
Note: This column is only displayed when an
LTE device profile is selected.
The percentage of total Continuous Reception
time used by the individual burst. The total
Continuous Reception time is the sum of all
individual burst Continuous Reception times.
Note: This column is only displayed when an
LTE device profile is selected.
The amount of Wi-Fi Active time for the
corresponding Burst type.
Note: This column is only displayed when a WiFi device profile is selected.
The percentage of total Wi-Fi Active time
used by the individual burst. The total Wi-Fi
Active time is the sum of all individual burst
Wi-Fi Active times.
Note: This column is only displayed when a WiFi device profile is selected.
The number of Joules per Kilobytes for the
corresponding Burst type calculated from the
amount of burst type energy and burst type
payload.

Individual Burst Analysis Table
The Individual Burst Analysis table provides information
about each individual burst in the loaded trace. You can
export the contents of this table in the CSV format by
right-clicking on it.
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The following table describes the statistics contained in
the Individual Burst Analysis section:
Field
Description
Start
The start time of the burst, in seconds, from the beginning
Time
of the trace.
Time
The time elapsed during the burst, in seconds.
Elapsed
Bytes The payload length, in bytes, for the burst. The payload
length considers only the data length of packets which
occurred during the burst.
Packet The number of packets in the burst.
Count
Burst One of the following Burst types according to the
request/response types in the loaded trace.
Burst Categories.
TCP Control
TCP Loss Recover
User Input
Screen Rotation
App
SvrNetDelay
NonTarget
LargeBurst
Periodical
Unknown
Userdef 1
Userdef 2
Userdef 3
•

HTTP Cache Statistics
The HTTP Cache Statistics section of the Statistics Tab
information page displays statistical information about
the cache based on the data in the loaded trace.
Caching is the process of storing data on the client side
to avoid the repeated download of data from the server.
This increases the amount of bandwidth available for
common requests and responses.
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This section contains the following sub-categories:
•

Cacheable vs. Non-Cacheable

•

Cache Simulation Results

•

Duplicate File Analysis
The following figure shows the columns and subcategories of the HTTP Cache Statistics section.

The HTTP Cache Statistics section contains the
following columns:
Column
Description
% of
Displays the amount of responses for this
Response row item expressed as a percentage of the
total number of responses.
% of
Displays the number of bytes for this row
Bytes
item expressed as a percentage of the
total number of bytes.
•

Cacheable vs. Non-Cacheable
The Cacheable vs. Non-Cacheable section of the HTTP
Cache Statistics section contains the following rows of
information:
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Row

•

Description

Cacheable

This field analyzes the cacheable
contents from the loaded trace. The
percentage of Cacheable Responses
is calculated from the amount of
Cacheable content and the amount
of total cache content. The
percentage of
Cacheable Bytes is calculated from
the number of
Cacheable bytes and total number of
cache bytes.

Specified - No Store

This field analyzes the files from the
loaded trace that are specified as “No
Store”. The percentage of No Store
Responses is calculated from the
amount of No Store content and the
amount of Total Cache content. The
percentage of No Store Bytes is
calculated from the number of No
Store bytes and the total number of
cache bytes.

Cache Simulation Results
The Cache Simulation Results sub-category of the HTTP
Cache Statistics section contains the Acceptable
behavior, Duplicate File Download, and Duplicate File
Download: Streaming sub-sections.

Row

The following tables describe the rows of information in
those sub-sections.
Description

Files downloaded
once

The percentage of total responses and total bytes for
files that were downloaded only once. This content is
populated from the caching missed contents.
Files specified as
This content is calculated from the “No-Store” HTTP
"No-Store"
responses. The percentages are calculated from the
cache diagnosis total and the number of total bytes.
Expired, but correct The percentage of total responses and total bytes for
304 responses
content with the HTTP response code 304.
sent from server
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Row
Expired,
downloaded again,
but file has
changed
Duplicate download
(not expired)

Description
The percentage of total responses and total bytes for
content where the HTTP response has changed from
the expired response.

The percentage of total responses and total bytes for
content which is a duplicate download but has not
expired.
Duplicate download The percentage of total responses and total bytes for
(expired, but no "If- content which is a duplicate download that has expired,
Modified Since"
and for which an “If-Modified-Since” header was not
header sent)
sent.
Duplicate download
(expired, but "IfModified Since"
header ignored)

•

The percentage of total responses and total bytes for
content which is a duplicate download that has expired
and contains an “If-Modified-Since” header that was
ignored.

Partial duplicate
download (Not
Expired)
Partial duplicate
download (expired,
but no "If-Modified
Since" header sent)

The percentage of total responses and total bytes for
content which is a partial duplicate download that has
not expired.
The percentage of total responses and total bytes for
content which is a partial duplicate download that has
expired and for which an “If-Modified-Since” header was
not sent.

Partial duplicate
download (expired,
but "If-Modified
Since" header
ignored)

The percentage of total responses and total bytes for
content which is a partial duplicate download that has
expired and for which an “If-Modified-Since” header was
ignored.

Duplicate File Analysis
The Duplicate File Analysis section of the Statistics Tab
information page displays information about duplicate
files that were downloaded during the trace.
The Duplicate File Analysis section contains the
following information:

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

Field

Description

Duplicate download
(Cache not expired)

The percentage of total responses and
total bytes for content which is a
duplicate download, and for which the
cache has not expired. These values are
calculated with the total cache expiration
count and cache expiration ratios.
The percentage of total responses and
total bytes for content which is a
duplicate download, and for which the
24-hour cache has not expired.
The percentage of total responses and
total bytes for content which is a
duplicate download, and for which the
cache has expired.
The percentage of total responses and
total bytes for content which is a
duplicate download, and for which the
24-hour cache has expired.

Duplicate download
(24 hr. cache not
expired)
Duplicate download
(Cache expired)

Duplicate download
(24 hr. cache
expired)

•

Energy Efficiency Simulation
The Energy Efficiency Simulation section of the Statistics
Tab information page displays the overall energy
efficiency from the loaded trace. The section lists the
amount of energy used for each of the different types of
energy consumption that can affect the performance of
the application, or the energy level of the device.
Note: The information displayed in this section depends
on the type of device profile that is selected.
When a 3G device profile like AT&T 3G is selected, the
Energy Efficiency Simulation section appears like the
following:
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When an LTE device profile like AT&T LTE is selected,
the Energy Efficiency Simulation section appears like the
following:

When a WiFi device profile like AT&T WiFi is selected,
the Energy Efficiency Simulation section appears like the
following:

The following table describes all the statistics contained
in the Energy Efficiency Simulation section for either
type of device profile:
Field
CELL_DCH
(Active)
CELL_FACH
(Standby)
IDLE
IDLE->DCH
(Active)
FACH (Standby) >DCH (Active)

Description
The total DCH time energy expended in the loaded
traces. This is calculated from the RRC DCH time value
and the power DCH value.
The total FACH energy expended in the loaded trace.
This is calculated from the RRC FACH time value and
the power FACH value.
The total idle time energy from the loaded trace. The
idle energy should always be 0.
The amount of RRC IDLE to DCH (Active) state time
energy consumption.
The amount of RRC FACH (Standby) to DCH (Active)
time energy consumption.
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Field
DCH (Active) Tail

Description
The amount of energy consumed during the RRC DCH
(Active) Tail state period.

FACH (Standby)
Tail

The amount of energy consumed during the RRC FACH
Tail state period.

IDLE ->
Continuous
Reception
Continuous
Reception
Continuous
Reception Tail
Short DRX

The amount of energy consumed during all transitions
from the IDLE state to Continuous Reception.

Long DRX

The amount of energy consumed during the Long DRX
state.
The amount of energy consumed during the WiFi Active
state.
The amount of consumed during the WiFi Tail state.

WiFi Active
WiFi Tail

The amount of energy consumed during the Continuous
Reception state.
The amount of energy consumed during the Tail time of
the Continuous Reception state.
The amount of energy consumed during the Short DRX
state.

WiFi Idle

The amount of energy consumed during the WiFi Idle
state.

Total RRC Energy

The sum of the CELL_DEH (Active), CELL_FACH
(Standby), FACH (Standby) DCH (Active), IDLE DCH
(Active), and IDLE energy consumption amounts.

Joules per Kilobyte

The number of Joules per Kilobyte from the loaded
trace, calculated from the amount of total energy and
total bytes.
The total energy consumed during the GPS Active state.
In GPS Active state, the energy consumption will be
equal to the time multiplied by the energy draw for
Active GPS.
The amount of energy consumed during the Long DRX
state.

GPS Active

Long DRX
WiFi Active
WiFi Tail
WiFi Idle

The amount of energy consumed during the WiFi Active
state.
The amount of energy consumed during the WiFi Tail
state.
The amount of energy consumed during the WiFi Idle
state.
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Field
Total RRC Energy

Description
The sum of the CELL_DEH (Active), CELL_FACH
(Standby), FACH (Standby) DCH (Active), IDLE DCH
(Active), and IDLE energy consumption amounts.

Joules per Kilobyte

The number of Joules per Kilobyte from the loaded
trace, calculated from the amount of total energy and
total bytes.
The total energy consumed during the GPS Active state.
In GPS Active state, the energy consumption will be
equal to the time multiplied by the energy draw for
Active GPS.

GPS Active

5.2.6. Waterfall Tab
The Waterfall tab displays a waterfall view chart of the TCP
connections from the trace spread over time. The chart can be
expanded or contracted to get a detailed view into the connections in
the trace data. The following image shows the Waterfall Tab. (Note:
The URLs of the TCP connections have been deliberately hidden.)

1. As the key at the bottom of the tab indicates, the color-coded plots on
the chart indicate the following information for each connection listed
on the left side of the chart:
Label

Description

DNS
Lookup

The time until the DNS
lookup was completed.

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Video Optimizer User Guide

Initial
Connection
SSL
Negotiation
Request
Time
Time to
First Byte
Content
Download
3xx result
4xx+ result

The time until the initial
connection was made.
The time spent in SSL
negotiation.
The time spent requesting
data from the server.
The time until the first byte
was downloaded.
The time spent downloading
the content.
An HTTP response code in
the 300 range.
An HTTP response code in
the 400 or 500 range. These
codes indicate an error.

2. When any of the color-coded plots on the chart are clicked, a
Request/Response Detail dialog box (like the following) is shown:

3. The tabs on the dialog box show details about the connection,
information about the request, and the actual content of the response.
The request/response data is like the detail provided in the
Request/Response View table on the Diagnostics tab.
•

Multiple Simultaneous connections to many end points
Double clicking on the results section of the Multiple Simultaneous
Connections to Many Endpoints best practice navigates to the
waterfall tab.
The Waterfall tab displays appropriate domain names and IP addresses and
shows the total connections at any point in time in the graph where a
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user hovers. The Maximum Simultaneous Connections count for the trace
is highlighted using a blue vertical line indicator at the moment when the
most connections were open

Double clicking on the results section of multiple simultaneous
connections navigates to the waterfall tab shows the maximum
connections at that point.

6. Appendix I
The sections in Appendix I list the error messages for the Data Collector and for Video
Optimizer.
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6.1. Data Collector Error Messages
The following table lists and describes the error messages that can appear
when using the Data Collector option in Video Optimizer.
Error Message
Condition
Please enter trace
folder name.

This error occurs if data collection is started without
providing a trace folder name.

Trace folder name
cannot have
special characters
or spaces.
Trace folder
already exists! Do
you want to
overwrite existing
trace?
SD card is either
not available or it is
mounted. Please
check the SD card
before running
Video
OptimizerData
Collector.
SD Card mounted,
Video Optimizer
Data Collector
trace session
terminated.
SD Card memory
full, stopping Video
Optimizer Data
Collector.
Video Optimizer
Data Collector
trace session can't
be started with
Flight Mode on and
no active WIFI
connection.

This error occurs if data collection is started, and the
trace folder name contains either non-alphanumeric
characters, or spaces.
This error occurs if data collection is started, and the
trace folder name already exists. When this error
occurs, click Ok to proceed and overwrite the folder
contents, or press Cancel to provide another name.
The Data Collector writes data files to a folder on the
device's onboard SD card—but the SD card must not be
mounted during data collection. This error occurs if no
SD card is detected, or if the SD card is mounted when
starting the Data Collector.

When the Data Collector finishes collecting data, it
writes the data files to the device's onboard SD card—
but the SD card must not be mounted during data
collection. This error occurs if data collection is started,
and the SD card is mounted.
This error occurs during data collection, if the data
collection process terminates because the SD card is
full.
This error occurs if data collection is started when the
device is in Flight Mode and there is no active WiFi
connection.
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Error Message

Condition

Video Optimizer
This error occurs if Flight Mode is turned on while there
Data Collector
is no active WiFi connection and data collection is taking
trace session
place.
stopped due to
Flight Mode being
turned on while
there was no active
WIFI connection.
Video Optimizer
Data Collector
failed to start!
Video Optimizer
Data Collector
trace collection
stopped.
Video Optimizer
Data Collector
trace session can't
be started with no
active network
connection.

This message appears if an unexpected error occurs
when the Start Collector button is clicked.
This error occurs during data collection, if the data
collection process terminates unexpectedly.

This error occurs if a trace session is started with no
active network connection.

6.2. Video Optimizer Error Messages
The following table lists and describes the error messages that can appear
when using the Video Optimizer.
Error Message

Condition

iOS: Remote Virtual Interface (rvi)
error.

There was a disconnect between the
mac interface and RVI. Please
disconnect and reconnect the device
or restart the device for continuation.

iOS: Video Optimizer is unable to
locate Wireshark/Dumpcap, Please
update the Wireshark location in
the preferences setting.

This error messages occurs when the
location is not configured properly. The
default location is under Applications.

iOS: Error.rvi.reset connection

There was a disconnect between the
mac interface and RVI. Please
disconnect and reconnect the device
or restart the device for continuation.
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Condition

Missing Prerequisite Library:
Unable to detect prerequisite
dependency ideviceinstaller.
Please verify.

This message occurs when one of the
pre-requisites is not installed.

Missing Prerequisite Library:
Unable to detect prerequisite
dependency libimobiledeivice.
Please verify.

This message occurs when one of the
pre-requisites is not installed.

Missing Prerequisite Library:
Unable to detect prerequisite
dependency ifuse. Please verify.

This message occurs when one of the
pre-requisites is not installed.

“Video Optimizer requires Npcap
installed in WinPcap APIcompatible Mode. It can be found
at: https://nmap.org/npcap/

The Video Optimizer application is
dependent on WinPcap, and it looks
for the WinPcap installation during
every launch. This error occurs if
WinPcap is not found, or if Npcap is
not installed in WinPcap APIcompatible Mode
This message is displayed when
FFprobe is not installed on the
machine or the path is not set
correctly.

The Startup Delay cannot be set on
this video stream. You can log a
support ticket by visiting Help ->
Support…
Video Optimizer requires
AppleQuartz renderer. Please set
apple.awt.graphics .UseQuartz flag
to true
Unexpected Exception: exception
message
The previous operation had caused
the system to reach it's memory
limit. To recover, Video Optimizer
had to restart the application

Video Optimizer is unable to open a
file of this size.
Please Save As... to a local disk
and open from there.

This error occurs if the Video Optimizer
is being used on a Mac OS, and the
apple.awt.graphics.UseQuartz flag is
not set to true.
This error occurs if Video Optimizer
encounters an unexpected exception.
This occurs if Video Optimizer reaches
the maximum amount of memory
allocated for it. The message also
displays 2 buttons – Edit Memory
Settings, and OK. Clicking on the Edit
Memory Settings button navigates the
user to File->Preferences so that the
user can edit the memory allocation.
Clicking on OK navigates the user to
the Best Practices/Results tab.
This error occurs if the opening of a
trace file will force Video Optimizer to
reach the maximum amount of
memory allocated for it.
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Error Message

Condition

Video Optimizer is unable to open a
file extension type file. Please Save
As... to a local disk and open from
there.

This error occurs if the type of the file
that is being opened is not recognized
by Video Optimizer.

Invalid trace in directory: trace
folder path and exception message.

This error occurs if Video Optimizer
encounters data in a trace file that is
invalid when performing analysis.
Occurs if there is an error while saving
the Diagnosis Chart to an image file.

An error occurred when trying to
save the chart.
No trace loaded. Please load trace
files before selecting this option.

This error occurs if one of the following
menu options is selected before a trace
file has been opened in the Video
Optimizer:
•

Video Optimizer could not find trace
folders in selected path. Please
select a valid trace folder path.
The USB device got disconnected.
Please check the connection.

Video Optimizer Collector is already
running on the device. Please stop
it and try again.
Time values must be numeric.

Start time must be less than End
Time.
Start Time and End Time must be
between 0.00 and trace length.

Time Range Analysis (Tools
Menu)
• PCAP File Analysis (Tools Menu)
• Select Applications/IPs (View
Menu)
This error occurs when a folder that
does not contain valid trace files is
selected when using the Open Trace or
Data Dump menu options.
Occurs when a device that is
connected via USB to a device running
the Data Collector, is disconnected
unexpectedly.
Occurs when an instance of the Data
Collector is running on a device while
another instance is started.
Occurs in the Time Range Analysis
Dialog if a nonnumeric value is entered
for the Start or End time.
Occurs in the Time Range Analysis
Dialog if a Start Time value is entered
that is greater than the End Time value.
Occurs in the Time Range Analysis
Dialog if time value is entered that is
less than 0 or greater than the total
time of the trace.
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Error Message
The system is unable to open .csv
files by default. Please set a default
program for .csv files.

Unable to connect to printer: printer
name.
Error in parsing alarm analysis info.

More than one device or emulator is
connected to PC.

Could not find device or emulator
connection. Please verify the
connection and ADB daemon is
started.

Video Optimizer User Guide

Condition
Occurs if the Export option is selected
to save one of the charts or tables in
the Overview, Diagnosis and Statistics
tabs to the .csv format, and there is no
default program set in the system for
.csv files.
Occurs when Video Optimizer is unable
to connect to a printer when the Print
option is selected in the File menu.
Occurs when Video Optimizer is unable
to parse information about an alarm on
the device.
Occurs if the computer is connected to
multiple devices of device emulators,
when the Start Collector option on the
Data Collector menu is selected.
Occurs if the user is not connected to a
device or device emulator, or if the
ADB daemon is not started, when the
Start Collector option on the Data
Collector menu is selected.

An unexpected error has occurred,
please restart the device.

Occurs when there is an unexpected
error in the device emulator.

Connection to device or emulator is
lost. Please wait for some time
before starting data collector.

Occurs if there is an error with the ADB
connection.

Trace directory already exists. Do
you want to overwrite trace files in
the directory?

Occurs if an existing Trace directory
name is entered in the dialog box when
the Start Collector menu option is
selected on the Data Collector menu.

Unable to create the Emulator trace
directory.

Occurs when the trace directory cannot
be created.

Trace name which you want to
replace is currently loaded. Do you
want to clear the trace?

Occurs if the name of the currently
loaded Trace is entered in the dialog
box when the Start Collector menu
option is selected on the Data Collector
menu.
Occurs if there is an error when the
Start Collector menu option is selected
on the Data Collector menu.
Occurs if the device is not supported by
the Data Collector.

Error starting Video Optimizer Data
Collector.
Error tcpdump not compiled for this
device.
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Error stopping
Video Optimizer Data Collector.

Error pulling Video Optimizer Data
Collector traces.
Video Optimizer Analyzer stopped
unexpectedly.
ADB Rejected the
Video Optimizer Data Collector
device Connection.

Video Optimizer User Guide

Condition
Occurs if there is an error when
stopping the Video Optimizer Data
Collector (using the Stop Collector
menu option on the Data Collector
menu) after it has been started from
Video Optimizer.
Occurs if there is an error when pulling
Trace files from the Video Optimizer
Data Collector to the local system.
Occurs if the Data Analyzer
unexpectedly stops.
Occurs if the Android Debug Bridge
(ADB) cannot connect to the device.

Emulator SD card is full. Please free Occurs if the Emulator does not have
some space to start Video
enough space on its SD card to save the
Optimizer Data Collector.
trace files collected by the Video
Optimizer Data Collector.
Please set your device USB Mode
to "Charge Only" - otherwise the SD
Card is not available but is required
by application.
Video Optimizer requires a virtual
SD card to be configured when
using the Android Emulator.

Occurs if the Emulator does not have
an SD card available. An SD card is
required by the Video
Optimizer Data Collector when using
the Emulator.
Occurs if no virtual SD card was
configured before using the Android
Emulator.

Emulator SD card does not have
Occurs if the Emulator does not have
enough space; it must have 5 MB or at least 5MB of space available on its
more.
SD card to save the trace files
collected by the Video Optimizer Data
Collector.
Device SD card does not have
Occurs if a device does not have at
enough space; it must have 5 MB or least 5MB of space available on its SD
more.
card to save the trace files collected by
the Video Optimizer Data Collector.
Emulator SD Card memory full,
stopping Video Optimizer Data
Collector.

Occurs if the Emulator does not have
enough any memory remaining on its
SD card. When this error occurs the
Video Optimizer Data Collector is
stopped.
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Device SD Card memory full,
stopping Video Optimizer Data
Collector.

Unexpected error accessing
emulator SD Card:
exception message
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Condition
Occurs if the Device does not have
enough any memory remaining on its
SD card. When this error occurs the
Video Optimizer Data Collector is
stopped.
Occurs if there is an unexpected error
while the Video Optimizer Data
Collector is accessing the Emulator.

Unexpected error accessing device
SD Card: exception message

Occurs if there is an unexpected error
while the Video Optimizer Data
Collector is accessing the SD Card of a
device.

Device SD card is not available but
is required by application.

Occurs when the Video Optimizer Data
Collector attempts to access the SD
Card of a device when it is not
available.
When the Start Collector menu option
is selected on the
Data Collector menu, the user is
prompted to enter a Trace folder name.
This error occurs if the Trace folder
name contains an invalid special
character or a space. The folder name
can only contain alphanumeric
characters or a (-) special character.
Occurs if the Trace folder name that is
entered in the dialog box when the
Start Collector menu option is selected
on the Data Collector menu, is longer
than 50 characters.
Occurs if there is an error while
transferring the collected trace files
from the device or device emulator to
the local system.

Trace folder name should not
contain special characters or
spaces.

Trace folder name should not be
more than 50 characters.

Emulator error with tcpdump/key.db
push.

Emulator I/O exception caused data
collector failure.

This transfer is initiated by the Video
Optimizer Data Analyzer when the Stop
Collector menu option is selected on
the Data Collector Menu, and the Pull
Traces menu option is selected on the
Data Collector.
Occurs if there is an Input / Output
exception when the Data Collector tries

© 2017 AT&T Intellectual Property. All rights reserved. AT&T and the AT&T logo are trademarks of AT&T Intellectual Property.
Video Optimizer User Guide

AT&T Entertainment Experience Suite

Error Message

Video Optimizer User Guide

Condition
to connect to the device or device
emulator.

No application found to open PCAP
trace.
Please install an application like
WireShark for
PCAP analysis.

The Data Collector is started from the
Data Analyzer by selecting the Start
Collector option on the Data Collector
menu
Occurs if the PCAP File Analysis option
is selected on the Tools menu, but an
external tool (like WireShark) for
analyzing PCAP files is not installed.

Wireshark is a required utility and
could not be found, please install
Wireshark and set its path in
File:Preferences for Wireshark

Occurs if Wireshark PATH is incorrect
in preferences and system Path has
wrong Wireshark path or is missing.

No traffic.cap file found in trace.

Occurs if the PCAP File Analysis option
is selected on the Tools menu, but a
traffic.cap file is not found in the loaded
trace folder.
Occurs if the APK is unable to start.

Not able to start.
Video file is not valid.

Unable to read file.

Video display conversion of
video.mp4 to video.mov file failed.
ERROR: Trace
directory is empty

ERROR: Input file does not exist;
nothing to convert.

Occurs if the Video Optimizer
Image/Video Viewer attempts to load
an invalid video file, or if a trace is
loaded that contains an invalid video
file.
Occurs if the Video Optimizer
Image/Video Viewer attempts to load a
video file that it is unable to read, or if a
trace is loaded that contains a video file
that Video Optimizer is unable to read.
Occurs if the Video Optimizer Data
Analyzer fails while converting the video
file from .MP4 to .MOV.
Occurs if the Video Optimizer
Image/Video Viewer attempts to load a
video file, but the Trace directory is
empty.
Occurs if the .MP4 video file does not
exist when the Video Optimizer
Image/Video Viewer is attempting to
convert it to .MOV.
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Error Message
ERROR: No
permission to write to output file for
conversion.

ERROR: Input file
is a directory; cannot be converted.

ERROR: Output
file is a directory; cannot be
converted.

ERROR: Output
file still exists after deletion; cannot
be converted.
ERROR: Unable to read file.

ERROR: Video display conversion
of video.mp4 to video.mov file
failed.

ERROR:
Exception setting up video player.
Video is already Synched. Do you
want to Re-Sync again?
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Condition
Occurs if the Video Optimizer
Image/Video Viewer does not have
permission to write the output file,
when it is converting the .MP4 video to
the .MOV format.
Occurs if the Video Optimizer
Image/Video
Viewer
cannot
convert the input file (an .MP4
video) to the .MOV format.
Occurs if the Video Optimizer
Image/Video Viewer encounters a
directory name instead of a file name
when it is converting the .MP4 video
to.MOV format.
Occurs if the Video Optimizer
Image/Video Viewer encounters an
error when preparing the output file for
conversion from .MP4 to.MOV.
Occurs if a file that was placed in the
trace directory cannot be read by the
Video Optimizer.
Occurs if the Video Optimizer
Image/Video Viewer encounters an
error when converting the output file
from .MP4 to.MOV.
Occurs if there is an exception when
the Video Optimizer Image/Video
Viewer is initializing.
Occurs if the Sync Video button is
clicked when the video is already in
sync.

The previous sync point has been
cleared. In order to Re-sync the
video, select the desired time point
in the Video player and then press
the Sync Video button now.

Occurs if the Sync Video button is
clicked when no sync points have been
set.

ERROR: Multiple external video
files exist in the trace folder. Please
add only one external video and
remove the rest.

Occurs when there is more than one
video file in the trace folder when the
trace is loaded.
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Category String Error

Unexpected error exporting table
Error loading the list of profiles.
Error setting the selected profile to
the Video
Optimizer.

Error loading last device profile.
Default device profile is being used.
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Condition
Occurs when an invalid string is
entered for the name of a User Defined
Burst.
Occurs when there is an error
exporting the Burst Analysis Table.
Occurs when there is an error loading a
device profile.
Occurs when there is an error setting a
device profile in selected in the Select
Device Profile dialog box that is
opened by the Load option in the
Profile menu.
Occurs if there is an error loading the
device profile. In this case, the default
profile will be used instead.

Error reading device profile
attributes: attribute name.

Occurs when a Device Profile is loaded
that contains an unrecognized attribute
name.

Unable to save file due to the errors
below: file error(s).
Unable to open file due to errors
below: file error(s).

Occurs when there are file errors while
attempting to save a customized
Device Profile.
Occurs when there are file errors while
attempting to open a Device Profile.

Unable to load file due to errors
below: file error(s).

Occurs when there are file errors while
attempting to load a Device Profile.

Error writing to file:
file error(s).

Occurs when there is an error writing to
the file selected in the file chooser
dialog.
Occurs when there is an error opening
content in the Video Optimizer
Image/Video Viewer.

Unable to load content. Download
may have been interrupted.

Microsoft Network Monitor related
error.

Occurs when there is an error related to
the Microsoft Network Monitor.

Could not load Microsoft Network
Monitor trace file.

Occurs when there is an error loading a
trace file that was collected by the
Microsoft Network Monitor.
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Video Optimizer was unable to
open the file. It
may be necessary to install
Microsoft Network Monitor.

Occurs when a trace file that was
collected by the Microsoft Network
Monitor is opened, but Microsoft
Network Monitor is not installed.

Timeout in starting the collector
trace.

Occurs when the trace file is so large
that it time out before it can be loaded
by the Analyzer.
Occurs when the Start Collector menu
option is selected but the Data
Collector apk is not installed on the
device.
Occurs when activity by the Collector is
displayed in front of the main start
screen before the Collector is started.

Video Optimizer Collector is not
installed on the device.

Video Optimizer collector is not
started. Its current activity has been
brought to the front. Please exit the
activity and try again.
Video Optimizer collector is not
stopped. Please hide the activity on
the device and press OK.

Occurs when the Collector is not
stopped, and activity on the device is
displayed in front of the main screen.

Video Optimizer could not find a
trace in the selected folder. Please
select a valid trace folder.

Occurs when a trace folder is selected
(using the Open Trace menu option)
that does not contain valid trace files.

To perform video analysis you must
have VLC player 64 bit version.
Please check the user guide for
installation. Contact us for further
troubleshooting.

When a user with the wrong VLC
version (ie: 32 bit) opens a trace, and
the installed VLC is an incompatible
architecture with the Video Optimizer
installation (64 bit).

6.3. Glossary
This following table contains a list of Mobile Web-associated terms, with
their associated definitions. For a more comprehensive list, see the World
Wide Web Consortium (W3C).
Term

Definition

Age

A property of a Response Entity. The length of the
elapsed time since the Entity was either Served by
the Origin Server, or successfully validated.

Average Rate

The amount of data in KB over the time the trace
was run. Apps that stream content should score
high here, apps with few connections should score
lower.
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Term

Definition

Burst

Consecutive packets of data transferred in a batch
over a TCP connection. Bursts can be initiated by
the user, the app, or the network.

Cache

A local process implemented in the client that
creates copies of Response Messages and serves
them to the client on the Server's behalf, if it
remains identical to the Origin Server's copy.
When used properly, the use of Response Caches
significantly reduces application response time and
bandwidth consumption.

Cacheable

A response is cacheable if the requirements of the
Request Method, Request Header Fields, and the
Response Status indicate that it is cacheable.

Client

A program that establishes connections for sending
requests.

Connection

A virtual circuit, established at the Transport Layer,
that is used to connect two programs so that they
can communicate using TCP.

Content Negotiation

The mechanism for selecting the appropriate
representation for servicing a request.
The representation of entities in any response can
be negotiated (including Error Responses).

Core Network

The Internet backbone. The network that the Radio
Access Network is connected to.

Energy Consumption

As your application becomes more efficient, the
J/KB should decrease. This means you are
consuming less battery energy per kilobyte.

Entity

The requested content. Delivered as the payload of
Response/Request messages. Request and
Response messages do not always carry a
payload.
An Entity consists of entity-header that contains
meta-information and an entity-body that contains
web content, although some responses will include
only the entity-headers.
The expiration time associated with an Entity—
when specified by the Origin Server.
Beyond that point in time, the Cache can continue
serving the local copy of the Entity, but only if it
passes a Validation test.

Explicit Expiration
Time
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Term

Definition

File Types

A breakdown of all files seen during the trace (in
bytes). Files sent through HTTPs are listed as
Encrypted.

First-Hand

A property of a Response. A response that is
received directly from the Origin Server. Cached
Responses are copies of First-Hand
Responses.

Fresh

A property of a Response Entity. Indicates that a
Cached Response is still implicitly valid. A Fresh
Response is a response that has not exceeded
its Freshness Lifetime.

Freshness Lifetime

A property of a Response Entity. The period in
which a cacheable response remains implicitly
valid.
How long it takes for a cacheable response to
reach its expiration time.

Gateway

A Server that acts as an intermediary for another
server.
Unlike proxies, gateways behave like Origin
Servers, receiving resource requests. The
requesting client cannot be aware that it is
communicating with a gateway.

GPRS

General Packet Radio Services.
Single GSM error-corrected circuit-switched data
channel.

Heuristic Expiration
Time

The expiration time associated with an entity—
determined programmatically by Cache
management logic.
A Cache management strategy used whenever the
Origin Server doesn't specify an Explicit Expiration
Time.

HSDPA

High-speed Downlink Packet Access. In the
same way that EDGE uses techniques to
increase speeds over GPRS, HSDPA employs
these same techniques, as well as others, to
increase the speed of UMTS data channels. Also
known as UMTS/HSDPA. UMTS/HSDPA is a
wide-area wireless data service
Application level, stateless, communication
protocol.
Client/server communication consists solely of
independent pairs of Requests and Responses.

HTTP
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Term

Definition

Inbound/Outbound

Terms indicating the path of Request and
Response messages.
Inbound messages travel toward the Origin Server.
Outbound messages travel toward the User Agent.

Joules

The SI unit of energy.
The work required to produce one watt of power for
one second (think of Kilowatt Hours).

Long Burst Connection

A long burst is one that sends a large amount of
data in a short period of time. If most of the data is
consumed, this is a good way to send data (see
tightly grouped above).

Message

The basic unit of HTTP communication.

MIME

Multipurpose Internet Mail Extensions.

Non-Periodic
Connections

Connections that recur periodically can cause rapid
battery drainage. Consider if your periodic pings are
required, if the timing could be lengthened, or if
other alternatives exist (Pushing alerts is more
efficient than regular polling).

Origin Server

The server on which a given Resource either
resides or is created.

Pcap

Packet Capture
An API for capturing network traffic.
Unix-like systems implement Pcap in the libpcap
library; Windows uses a port of libpcap known as
WinPcap.

Proper Session
Termination

The percentage of connections that close
immediately with no delay. Connections that close
in a delayed fashion, keep the RRC state Machine
on longer - needlessly draining the battery.

Proxy

A program that acts as both a server and a client for
making requests on behalf of other clients.
Requests are either serviced internally, or are
passed on with possible translation, to other
servers.
A proxy MUST implement both the client and server
HTTP requirements.
A transparent proxy is a proxy that does not modify
the request or response beyond what is required for
authentication and identification.
A non-transparent proxy is a proxy that modifies the
request or response to provide some added service
to the user agent, such as group annotation
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Term

Radio Access Network
(RAN)

Definition
services, media type transformation, protocol
reduction, or anonymity filtering.
Except where either transparent or non-transparent
behavior is explicitly stated, the HTTP proxy
requirements apply to both types of proxies.
The UMTS wireless network, connecting mobile
devices to the Core Network.

Representation

A Response Entity that is subject to Content
Negotiation.
Multiple representations can be associated with a
Response Status.

Request

A request message from a client to a server
includes, within the first line of that message, the
method to be applied to the resource, the identifier
of the resource, and the protocol version in use.

Resource

Any network Data Object or Service that can be
identified by a URI.
Resources can be made available in multiple
representations (e.g. multiple languages, data
formats, size, and resolutions) or vary in other
ways.

Response

After receiving and interpreting a Request
Message, a web server fulfills the request by
sending back an HTTP Response Message, which
contains the requested content as the payload.

Semantically
Transparent

A property that describes the way a Cache
behaves. In terms of content quality, content
served from a Cache that is Semantically
Transparent matches that served from the Origin
Server.
Except for the addition of hop-by-hop headers, the
client receives Responses that are identical to FirstHand Responses.

Server

A program that accepts connections to service
requests and sends back responses.
Any given program can be capable of being both a
client and a server; our use of these terms refers
only to the role being performed by the program for
a connection, rather than to the program's
capabilities in general. Likewise, any server can act
as an origin server, proxy, gateway, or tunnel,
switching behavior based on the nature of each
request.
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Term

Definition

Session

HTTP Session. The conversation that takes place,
between a client and a server.
Initiated by the client but concluded by either the
client or the server.
Consists of a series of network Request-Response
transactions.
Lasts for the duration of the conversation, usually
minutes.

Session Termination

This graph is scoring the types and actions of the
TCP connections found in this trace.

Signaling overhead

The higher the percentile, better the performance of
your application. Signaling overhead indicates the
time spent in RRC state transitions. The lower the
signaling overhead number, lower the count of state
transitions, and the higher your percentile rank.

Simulation

Based on device profile.

Stale

A property of a response entity that indicates that
a cached response is no longer implicitly valid. A
stale response is a response that has exceeded its
freshness lifetime.

Stateful

In a session, at least one of the communicating
parties needs to save information about the session
history to be able to communicate.

Stateless

The communication consists
requests and responses.

Tightly Grouped
Connections

Connections that are grouped together efficiently
use the radio while it is turned on. Connections that
are spread out keep the radio on for a longer period,
adding to the battery drain.

Trace

A record of the Information generated by a device
and by the network communicating with the device.
Trace information can include packets transferred
between the device and network, radio energy
usage information, user input information, device
information, and information from peripheral
applications.

of

independent
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Term

Definition

Trace Benchmark

This graph benchmarks your trace to the results of
traces run on top mobile applications. This gives
you an idea of where your application stands in
comparison to other applications. The rankings here
do not signify anything specific other than a ranking.

Tunnel

An intermediary program that acts as a blind relay
in the Client/Server connection.
Once active, a Tunnel is not considered a party to
the HTTP communication.
Tunnels are initiated by an HTTP Request. A
tunnel ceases to exist when the connections
terminates.

UMTS

Universal Mobile Telecommunications System. The
3G version of the GPRS technology. Based on
GSM. UMTS radio link.

UMTS Data Channel

The link established between the mobile device and
the cell tower.

Upstream/Downstream

Terms that describe the direction in which
messages flow.
Messages travel from Upstream, to Downstream.

User Agent

The client that initiates a Request.
Clients are usually End-user programs, such as
Web Browsers, but they can also be Service
programs such as Spiders (web-traversing robots).

User Agent

A client application. Usually implements HTTP 1.1,
to communicate with a web server.

Validator

Timestamp information that accompanies Response
Entities.
Stored a Response Entity header field.
Used to validate Stale cache entries.
When an Origin Server sends a Full Response, it
includes a Validator in the Entity-header, which
along with the Entity-body, becomes a local cache
entry.
A Client (user agent or proxy cache) makes a
Conditional Request for a cached copy a Resource
when it must guarantee the Resource's validity. The
Server evaluates the condition based on the result
of comparing the value of its local copy of the
requested resource's validator (the current version
of the Resource), against that of the value of one in
the Request. If they match, it responds with a
special status code (usually, 304 (Not Modified))
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Term

Definition
and no entity-body. Otherwise, it returns a Full
Response.
Thus, we avoid transmitting the full response if the
validator matches, and we avoid an extra round trip
if it does not match.
A protocol element (e.g., an entity tag or a
LastModified time) that is used to determine
whether a Cache Entry is usable (i.e., an equivalent
copy of an entity.

Variant

At a given instant, Resources can have multiple
Representation(s).
Each Representation is referred to as Variant. Use
of the term Variant does not necessarily imply that
the resource is subject to Content Negotiation.

7. Appendix II
The sections in Appendix II describe how to use the legacy Rooted Data Collector APK.

7.1. Rooted Data Collector APK
Rooted collection is a legacy product and is no longer updated. It is still included in the
Video Optimizer package, but if you encounter issues, they are unlikely to be resolved
in a future release.

7.1.1. Prerequisites for using the Rooted Data Collector APK
To collect an application trace using the Data Collector APK, you need the
following:
• A Video Optimizer Data Collector APK (included in the install on your
computer)
• An Android test device running Android version between 4.x and 6.0 (rooted
Data Collector does not work on Marshmallow and above)

7.1.2. Installing Rooted Data Collector APK
1. Start a trace as described in Using Video Optimizer to Collect Data,
selecting the rooted option.
2. The apk will be installed on your phone.
•

Collecting a Trace Using the Data Collector
Once you have installed the Video Optimizer on your test device, you
can operate it directly on the device to collect a trace; or for devices that
do not allow you to capture trace video, you can operate the Data
Collector via a USB connection using the commands on the Start
Collector menu in Video Optimizer.
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To operate the Data Collector from Video Optimizer, do the
following:
Step 1. Select Preferences from the File menu.
Step 2. Select the General tab.
Step 3. For the Adb Path field, browse to the directory where the Android
Debug Bridge (ADB) executable is located, and select it.
Step 4. For mac(iOS) select the Wireshark path if not installed under the
default location displayed.
Step 5. Click Save and Close.
Step 6. Ensure that you have a USB connection between the test device
and the computer where Video Optimizer is installed.
Step 7. Select Start Collector from the Data Collector menu.
Step 8. On the test device, select OK when the “Allow USB Debugging”
prompt asks you to confirm the RSA key on the test device.
Step 9. Run testing scenarios on your app while Video Optimizer is
collecting data. For example, launch the app, exercise the main
functions of the app, and close the app.
Step 10.
Select Stop Collector from the Data Collector menu
The trace data, including video, will be transferred to the computer via
USB as part of the trace collection process.
Note: This method allows you to capture a video of the trace via USB
for Android devices that do not support the Video Optimizer Data
Collector capturing trace video directly.
To operate the Video Optimizer Data Collector directly on an
Android test device, do the following:
Step 1. Open the program list on your device (Figure), find the “Video
Optimizer” icon, and launch it.

Step 2. Click Accept on the Legal Terms screen (Figure) to proceed to
the main screen of Video Optimizer.
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Step 3. Use the controls on the Video Optimizer main screen to cancel
any running applications that you do not want to test.
Step 4. Select whether to record video with your trace and start the Data
Collector.
Step 5. Click Open Task Killer to stop running tasks and select the tasks
that you want to stop before you start collecting data. This
ensures that you are collecting trace data only from the
application that you want to test.
Step 6. Click Record Video to record video while you are capturing the
trace.
Step 7. Click Start Collector to start the Data Collector.
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8. Appendix III
This is an example of a .zprofile or .zshenv. You will need to add this to your profile
configuration. This works on Intel as well as Apple silicon.

arch_name="$(uname -m)"
#---------------------------------# HomeBrew
#---------------------------------if [ -x /usr/libexec/path_helper ]; then
eval `/usr/libexec/path_helper -s`
fi
if [ "${arch_name}" = "x86_64" ]; then
eval "$(/usr/local/bin/brew shellenv)"
if [ "$(sysctl -in sysctl.proc_translated)" = "1" ]; then
echo "Running on Rosetta 2"
else
echo "Running on native Intel"
fi
elif [ "${arch_name}" = "arm64" ]; then
eval "$(/opt/homebrew/bin/brew shellenv)"
echo "Running on ${arch_name}"
else
echo "Unknown architecture: ${arch_name}"
fi
#---------------------------------# JAVA
#---------------------------------export JAVA_HOME=$(/usr/libexec/java_home)
export EXT4J_JAVA_HOME=$JAVA_HOME
export PATH=$JAVA_HOME/bin:$PATH:/usr/bin/
#VLC
export LD_LIBRARY_PATH=/usr/local/bin:/Applications/VLC.app/Contents/MacOS/lib
export PATH=$PATH:/Applications/VLC.app/Contents/MacOS/lib
#---------------------------------# Android
# install sdk where ever is convenient
#---------------------------------export ANDROID_HOME=~/Library/Android/sdk
export ANDROID_ADB=$ANDROID_HOME/platform-tools/
export PATH=$PATH:$ANDROID_HOME/platform-tools:$ANDROID_HOME/tools
#---------------------------------# wireshark
# dumpcap
# tshark
# capinfos
#---------------------------------export PATH=$PATH:/Applications/Wireshark.app/Contents/MacOS
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